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2 Introduction

With the advent of Web Services, users and owners of many mainframe applications that used to
rely on just binary interfaces for communication have been trying to harness XML as a new
means of information exchange. This approach presents unique opportunities and challenges to
the programmers who are trying to efficiently adapt business applications in order to process and
produce XML documents with minimal disruptions to the existing system infrastructure. An
example of one such infrastructure would be a bank Call Support Center in which operators
utilize 3270 terminals to access a mainframe CICS® application that retrieves and updates
customer and account information. Creating new points of access to such a system may include
the addition of a Web-based interface, an automated Voice Response Unit (VRU), or a Web
service capability.

In this paper, we will describe how IBM® WebSphere® Studio Enterprise Developer™ tools help
you modernize your Enterprise assets, adapt them to process and produce XML messages, and
expose them as viable Web Services.
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3 Business Application Sample

Throughout this paper, we will use an existing CICS application that is included with Enterprise
Developer. First, you will install and run this application, then you will learn a how to enable
this application to process and produce XML messages using Enterprise Developer.

/ Account \

Details
DFHOACTD
3270 CICS Terminal

Interactive -

Program

LEGFRNT
Customer
Details

\\\\\; DFHOCSTD 4/////

CICS

Figure 1, Existing CICS Application

This CICS application consists of an interactive program, LEGFRNT, which calls two CICS programs,

DFHOACTD and DFHOCSTD. They, in turn, access the pB2" table to retrieve customer and account
information. This information is exchanged in a binary form via a CICS COMMAREA and the results are
displayed on a 3270 terminal. Screens that illustrate the interaction are shown later in this paper.

The rest of this paper assumes that you have some basic familiarity with operations of a CICS
. . ® ®
environment in OS/390 ~ or z/OS .

3.1 Parts of the existing business application

Here are the required programs for the current application:

e DFHOACTD
e DFHOCSTD
e LEGEFRNT
e TLEGMAP

e DFHSEDB?2
e DFH$SESQL

Account Details sample program)

Customer Details sample program)

CICS front end program for executing the business programs)
CICS BMS map for front end program)

creates DBZ tables for the sample programs)

DB2 bind for the sample programs DFHOACTD and DFHOCSTD)

~ o~ o~ o~~~
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e XMLSCEDA (creates CICS table entries).

These sample COBOL programs are included with Enterprise Developer. You can find the complete list
of pre-requisite software in Appendix A.

3.2 Setting up and running the existing business application

Follow the steps below to set up and run the application.

3.2.1 Preparing your datasets
To set up your application, you allocate the following partitioned data sets (PDS or PDSE) then transfer
the associated members. The source files for these programs are shipped in the “Web Services for
Enterprise White paper” directory on the Enterprise Developer Installation CD. You can use the IDE for
7/OS tools to transfer the source files as members to the appropriate datasets on z/OS.

Data set name Data set members Data set characteristics
XML .COBOL COBOL source code: RECFM: FB LRECL: 80
° DFHOACTD BLKSIZE: any (e.g. 4000)
d DFHOCSTD
. LEGFRNT
XML .CNTL JCL: RECEFM: FB LRECL: 80
. DFHSEDB2 BLKSIZE: any (e.g. 4000)
° DFHSESQL
. XMLS$CEDA
XML .LOAD Load modules RECEFM: U LRECL: O
BLKSIZE: 32760
XML .OBJECT Object decks RECFM: FB LRECL: 80
BLKSIZE: any (e.g. 4000)
XML .DBRMLIB DB2 sample data RECFM: FB LRECL: 80
BLKSIZE: any (e.g. 4000)
XML .BMS LEGMAP (BMS map) RECFM: FB LRECL: 80
BLKSIZE: any (e.g. 4000)

3.2.2 Configuring DB2

Use the DB2 sample program DSNTIAD (which is shipped with DB2) to create the DB2 tables
“ACCOUNT” and “CUSTOMER” which are needed by the sample programs. Use DFHSEDB2 as a
template for creating the tables. Create the tables by running the DB2 sample program DSNTIAD. The
DSN SYSTEM (...) parameter is the name of your DB2 subsystem. This DB2 subsystem should be
connected to your target CICS. You should replace DSTNIAxx with the correct name that corresponds to
the release level of your DB2 subsystem, for example, DSTNIA61 for DB2 6.1. Note that starting with
release 6 of DB2, DSNTIAD is shipped as source and a load module; in prior releases, it is available as
source only. The sample JCL to assemble the DSNTIAD source can be found in
DB2.SDSNSAMP(DSNTIJTM) as one of the steps in the control file:

//SYSTSIN DD *

DSN SYSTEM(...)
RUN PROGRAM (DSNTIAD) PLAN (DSNTIAXX)
END

//SYSIN DD DSN=DFHSEDB2, DISP=SHR

3.2.3 Assembling BMS maps

Providing a Web Services Interface To a CICS Application 7
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To create the layout of the CICS front end to the sample programs, you assemble the BMS map
LEGMAP using the procedure DFHMAPT supplied with CICS. The resultant COBOL copybook is
referenced in the LEGFRNT program.
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3.2.4 Pre-compiling the existing programs

Since the sample programs contain EXEC SQL statements they must be pre-compiled. Use the DB2 pre-

compiler DSNHPC to pre-compile the sample programs DFHOACTD and DFHOCSTD.
3.2.5 Compiling and link-editing the sample

Compile and Link-Edit the sample and front end programs DFHOACTD, DFHOCSTD and LEGFRNT
using the procedure IGYWCL as three separate CICS programs. Be sure to include the CICS compile

option. Ensure that the resulting load modules are in a load data set visible to the CICS RPL.
3.2.6 Binding the DB2 tables

To allow the sample programs to access the DB2 tables use the sample DFH$SESQL to perform a DB2
bind for the programs DFHOACTD and DFHOCSTD. The contents of DFHSESQL should be as follows:

DSN SYSTEM ..)

BI ND PACKAGE( EBUSCOL) -
OMNER( TONYF) -
QUALI FI ER( TONYF) -
MEMBER( DFHOCSTD) -
LI BRARY(' TONYF. DBRMLI B. DATA' ) -
ACTI ON(REP) -
| SOLATI ON( CS)

VALI DATE( Bl ND)
DYNAM CRULES( Bl ND)
ENABLE( CI CS)

BI ND PACKAGE( EBUSCOL) -
OMNER( TONYF) -
QUALI FI ER( TONYF) -
MEMBER( DFHOACTD) -
LI BRARY(' TONYF. DBRMLI B. DATA' ) -
ACTI ON(REP) -
| SOLATI ON( CS)
VALI DATE( Bl ND)
DYNAM CRULES( B ND)
ENABLE( CI CS)

BI ND PLAN( EBUSPLAN) -
OMNER( TONYF) -
QUALI FI ER( TONYF) -
ACTI ON(REP) -

PKLI ST( EBUSCOL. *)

| SOLATI ON( CS)

VALI DATE( Bl ND)
DYNAM CRULES( Bl ND)
ENABLE( CI CS)

END
COW T,

Note that you should use your DB2 subsystem ID as the parameter to the DSN SYSTEM directive. Also

replace the highlighted fields with your system’s high-level qualifier.
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3.2.7 Configuring CICS

Define various resources to CICS. A sample XMLS$CEDA is provided to assist with this:

® A transaction named LEGF

® The programs DFHOACTD, DFHOCSTD and LEGFRNT

¢ The BMS map LEGMAP

® A DB2ENTRY for LEGF that connects it to sample plan EBUSPLAN
¢ A DB2 transaction for LEGF.

3.2.8 Running the application
To start the application bring up a CICS terminal and run transaction LEGF. The following screen should
appear. Note: the following instructions illustrate transaction 1. The procedure for transaction 2 is the
same.

PLEASE CHOOSE A TRANSACTION:

1. CUSTOMER DETAIL SCREEN
2. ACCOUNT DETAIL SCREEN

ENTER YOUR CHOICE ====>

If you enter 1 as your choice the following will appear on the screen:

CUSTOMER DETAIL SCREEN

CUSTOMER NUMBER: 00001

FIRST NAME:

LAST NAME:

ADDRESS:

CITY:

STATE:

COUNTRY :

10 Providing a Web Services Interface To a CICS Application
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Change 00001 to 00004 and press Enter. The following screen will appear:

CUSTOMER DETAIL SCREEN

CUSTOMER NUMBER: 00004

FIRST NAME: JOHN

LAST NAME: ROYSON

ADDRESS: 15 MISTYVIEW

CITY: ROANOKE

STATE: TX

COUNTRY: US

Note that this program is not a complete CICS application and in order to return to the initial screen you
will need to restart the LEGF transaction.

Providing a Web Services Interface To a CICS Application
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4 XML-enabled Business Application

In order to allow XML documents to flow through to the existing business programs, the source of those
programs is passed through the XML Enablement tool in Enterprise Developer. The tool generates a set
of COBOL programs called “XML converters” (Inbound and Outbound) based on the original binary
interface. The tool also generates a template COBOL program called “Converter driver” that illustrates
how to invoke the converters. In section 4 we will show how to augment the driver with EXEC CICS

statements to call the existing business application in concert with calling the XML converters.

An

interactive menu-driven 3270 front-end program facilitates local testing of the new application. The
diagram below shows the structure of the modernized application.

CICS Terminal
(for testing)

Interactive

document

Inbound
XML

Outbound
XML
document

L

Inbound
XML

document]

~

Account
Details
DFHOACTD

Ill]éf%;ﬂ}— XML data
00— >| | “mbound”
< | | Sonverter
: ACTDCNVI
Binary data
Driver Binary data
ACTDDRV
Binary data
10—, > | “Qutbound”
Il Converter
<:“:”] ACTDCNVO
XML data
XML data
éf%;“}— XML data
(0
I >| | “Wbound”
<0 | | Sonverter
: CSTDCNVI
Binary data
Driver Binary data
CSTDDRV
Binary data
10— > |“Qutbound”
1] Converter
<100 | cstocNvo

XML data

Customer
Details
DFHOCSTD

XML data

/

Figure 2, Existing Business CICS Application Enabled for XML

Parts of the application are described in detail later in the paper.

The rest of the paper describes the process that you follow to replace the binary interface of two sample
COBOL CICS programs with an XML interface and then how to turn them into full-fledged Web

Services.
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4.1 Using the Enterprise Developer XML Enablement Tool

This section describes how to use the XML Enablement tool in Enterprise Developer to generate XML
Converters and a Driver template. Before you read section 4 you should familiarize yourself with the
basic concepts of Enterprise Developer, including its IDE for z/OS feature.

Required programs for this sample:
e DFHOACTD (Account Details sample program)
e DFHOCSTD (Customer Details sample program) .

These COBOL programs are shipped with Enterprise Developer samples.

During development of your application, you will also use the following programs and datasets:

e ACTDCNV(I,O) - account details inbound/outbound XML converters that are
generated by the XML Converter generator. The inbound XML converter is a
COBOL program that processes an incoming XML document and converts
contents of its elements into a COBOL data structure. The inbound
converter uses high-performance XML parsing capabilities of the latest IBM
Enterprise COBOL compiler and runtime to efficiently parse the inbound XML
document. During the parse, the inbound XML converter converts XML data
and stores it in the existing application’s COBOL data structure (in case
of a CICS application this data structure 1is a CICS COMMAREA). The
conversion and moving of data is based on proprietary algorithms that
provide high efficiency 1in transforming character data from the XML
document into appropriate COBOL data. The outbound XML converter i1is a
COBOL program that takes the results of the execution of the existing
transactional program and converts COBOL data into an XML message. That
message will be returned to the client. In case of an error during
execution of the transaction, an XML-based error message will be returned

e CSTDCNV(I,O) - customer details inbound/outbound XML converters that are
generated by the XML Converter generator

e ACTDDRV (or ACTDSOAP if you want to enable Web Services) - account details
XML converter driver that is generated by the XML Converter generator. The
XML converter driver is a COBOL program that shows the invocation sequence
for the inbound converter, the existing program and the outbound converter

e CSTDDRV (or CSTDSOAP if you want to enable Web Services) - customer
details XML converter driver that 1is generated by the XML Converter
generator

e XMLFRNT - CICS front-end program for executing sample programs (you don’t
need this program if vyou will Dbe using Web Services to access your
application)

e XMLMAP - CICS BMS map for front-end program (you don’t need this program

if you will be using Web Services to access your application)
e DFHSEDB2 - creates DB2 tables for the sample programs
e DFHSESQL - DB2 bind for the sample programs DFHOACTD and DFHOCSTD
e XMLSCEDA - creates CICS table entries.

Follow the steps outlined below to create, set up and run your XML-enabled business application.

Providing a Web Services Interface To a CICS Application 13
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4.1.1 Locating your existing application
Locate the sources for DFHOACTD and DFHOCSTD on your z/OS system. In order to do that, you can
use IDE for z/OS tools in Enterprise Developer. You define and connect to the remote z/OS system. For
this example, let’s assume that the system you connect to is called STLABE1. Once you are connected to
STLABEI, locate the sources for DFHOACTD and DFHOCSTD. Let’s assume that they are located in a
PDS called XML.COBOL under the high level qualifier (HLQ) TONYF.

14 Providing a Web Services Interface To a CICS Application
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4.1.2 Creating a project in Enterprise Developer
Create a local container for the generated XML Converters and the Driver template. This local container
is called “Simple Project”. In Enterprise Developer, switch to the Resource perspective and invoke the

New Project wizard. Select “Simple” as the type of the project you want to create. Follow the wizard to
create a project called “XML Account Test” (Fig. 3.)

cﬁ’ Resource - Welcome - IBM WebSphere Studio Enterprise Developer

=loix|
File Edit Mavigate Search Project Run  ‘Window Help
|IS-BR&|B|%-|]|s]ve-2-
E B3, Mavigator - X Z Xl
Byl = | B o

-z %ML Account Test

WebSphere Studio Enterprise Developer 5.1.2

To start working with IBM webSphere Studio Enterprise Developer 5.1.2, do as follows:

% Launch the help system and read the product overview:

1. Click Help = Help Contents,

2. Expand Product Overview, and read the topics included in that category,

{3 Read Getting Started content and work through one or more of the tutorials:

1. Under Product Overview, expand Getting Started and select a tutorial,
o= outline

Aan outline is nob available,

o=

3 Tasks (0items)

WOH e x
I J'I ! | Description Resource | In Folder I Location
Figure 3, XML Account Test Project
Providing a Web Services Interface To a CICS Application 15
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4.1.3 Moving your existing application to Enterprise Developer
Use Copy and Paste operations on the source COBOL files for DFHOACTD and DFHOCSTD to copy
them into your local XML Account Test Project. (Fig. 4) Hint: You use the “Go Into” and “Refresh”
actions to “go into” the XML.COBOL PDS represented as a Folder in the Resource perspective.

If the source files are located in the local file system on your PC, use the File> Import operation provided
in the Workbench to import the source files into your local project.

4P Resource - Welcome - IBM WebSphere Studio Enterprise Developer - IEIliI

File Edit Mavigate Search Project Run  ‘Window Help

EEREAEERET
Welcome X l
WebSphere Studio Enterprise Developer 5.1.2

To start working with IEM Websphere Studio Enterprise Developer 5.1.2, do as follows:

@ Launch the help system and read the product overview:
1. Click Help = Help Contents.

2. Expand Product Overview, and read the topics included in that category.

(@ Read Getting Started content and work through one or more of the tutorials:

1. Under Product Dverview, expand Getting Started and select a tutorial,

3=/ outline x

An outline is not available,

& Tasks (0 items) B = ow X

[ [ t [ pescription Resource | In Folder | Location

*ML Account Test

Figure 4, XML Account Test Project With Source

Note that the IDE appends extension to the source file name. This way you can use file type-specific
Enterprise Developer tools like a language-sensitive editor.
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4.1.4 Invoking the XML Converter generator wizard

Invoke XML Converter generator for the source program DFHOACTD.cbl. To do that, select

DFHOACTD.cbl in the Navigator view and invoke the pop-up menu by pressing the right mouse button.
(Fig. 5)

4P Resource - Welcome - IBM WebSphere Studio Enterprise Developer

(=]
File Edit Mavigabe Search Project Run  Window Help
Is-gaalg%-[ls]wec-o-
E B o w x || [2)welcome Xl
Blle 2 &= F WebSphere Studio Enterprise Developer 5.1.2
BT ¥ML Account Test

H a DFHOCSTD MHew ¥ b start working with I6M WebSphere Studio Enterprise Developer 5.1.2, do as Follows:
Open
Open With ¥ B Launch the help system and read the product overview:
Qpen fs
1. Click Help = Help Contents,
] C
e 2. Expand Product Overview, and read the topics included in that category.
E Paste:
8 Delete
Mave b Read Getting Started content and work through one or more of the tutorials:
Rename 1. Under Product Dverview, expand Getting Started and select a tutorial,
£y Impart...
£} Export...
Add Bookmark. ..

o= .
= Outline
n.i €§3 Refresh
#An outline is not availat
Run ¥alidation
gﬂ Debug on Server, .,

ﬂ Run on Server. ..

@9 Profile on Server... Bsks (0 items)
Team 3
Compare 'With »
Replace With 3

Link Likilities 3

2
3

+
o e x

| Locakion |

| H | Description Resource | In Falder

el Services

Generate XML converter...

Propetties

Enterprise Services 13

#¥ML Account Test/DFHOACTD.chbl

Figure 5, Invoking the XML Converter generator

Providing a Web Services Interface To a CICS Application

17
© Copyright IBM Corporation 2002, 2004. All Rights Reserved.



4.1.5

Specifying input and output files for the wizard

Use the first page of the XML Converter wizard to select input and output files for the Converter, Driver
template, and the XML Schema. Hint: The XML Schema is automatically generated that contains the
description of the names and types of XML elements. These elements can appear in an XML document
that our program will process and generate. For more information on XML Schema visit
http://www.w3.org/XML/Schema

# Generate XML converter Wizard

File, data set, or member selection

Select the source and targets for the XML converter

Select the source for the XML canverter

Source file or member: I <ML Account Test/DFHOACTD, chl Browse. ..

Select targets For the XML converter

iyl

Converter Folder: I FaML Account Test Browse, .,
Input converter file name: I DFHOACTDI .chl
Output converter File name: I DFHOACTDO .chl
Converter driver fils name: | DFHOACTDD .chl

[~ Generate converters and converter driver to the Input converter File

Select kargets Far the XML Schema
| T5ML Account Test

%50 file Folder:

Browss, .. |

Jisd

Input message %50 file name: I DFHOACTDI

Output message S0 file name: I DFHOACTDD Lxsd

[~ Cwerwrite files without warning

Cancel

= Barl I Mext = I

Fimish |

Figure 6, Generate XML Converter Wizard

On this page, the fields are as follows:

CICS XML File Selections
e Input converter file name

o ACTDCNVI.cbl
e Output converter file name

o ACTDCNVO.cbl
e Converter driver file name

o ACTDDRYV.cbl
Enter these names in the dialog page shown on the left
(Replacing DFHOACTDI with ACTDCNVI,
DFHOACTDO with ACTDCNVO, and DFHOACTDD
with ACTDDRYV)

Source file - specify where your existing COBOL program is located

Converter folders -
program(s)

specify folder(s)

Converter file names - specify the name (s)

Converter driver file name -
driver.

Generate converters

where the wizard will generate converter

you want to give your converter file(s),
specify the name you want to give your converter

and converter driver to one file -

select 1if you want to

generate the converters and converter driver to the file specified in the

converter file name” field. The driver will

XSD file folders - specify where the wizard will generate the XML Schema file(s)

XSD file names - specify the name (s)

Overwrite files without warning -
files

you want to give your XML Schema file(s)
select if you want to overwrite existing output

“input
appear first in the file.

18
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4.1.6 Specifying the generation options
Use the second page of the XML Converter wizard to specify generation options for your Converter and
Driver programs. Choose the host code page for the Host system were you will deploy the converters.
Also set Driver type to CICS. There is no need to modify the rest of the specified defaults on this page.

(Fig. 7)

4F Generate XML converter Wizard x|

XML converter options

apecify options for the XML converker @

Specify identification attributes
Program narne: I ACTOCNY

Author name: I WSED

Specify ¥ML converter driver bype

Driver type: A

Configure XML message processing

Maximum message size (KB I 32

Inbound code page: |114D 34, Canada, etc. Euro Country Extended j
Host code page: |114D 34, Canada, etc. Euro Country Extended j
Zutbound code page: |114D 34, Canada, etc, Euro Country Extended j

Specify XML namespaces

Inbiound namespace: | hikbps fivna, DFHOAC TOLL com)'schemas DFHOACTDIT

Outbound namespace: | htkp: f fvmea DFHDACTDO  com'schemasDFHOACTDC

Cwerride Imporker Options. |

« Back Mext = | Einish I Cancel

Figure 7, Generation Options Selection

On this page, the fields are as follows:

e Program nane - specify the “stenf value for the program names in the PROGRAM ID

paragraph of the |DENTIFICATION DIVISION in the COBOL programs that this wizard
will generate. For example, if you enter ACTDCNV, the wzard wll generate
ACTDCNVI  for the inbound converter program name, ACTDCNVO for the outbound
converter, and ACTDCNVD for the converter driver.
Aut hor name — specify the value for the AUTHOR paragraph
e Driver type — specify the desired driver type. Choose “CICS’. The CICS driver type
provi des sonme conveniences to mnimze the need for nodifications.
e Maxi num nessage size — specify the maxi mum size of the XML message that will need
to be allocated when processing and generating the XM. nessage.
e Code pages - specify code page(s) for the encoding of the inbound and out bound XM
docunents, and the code page for the host data.

e Inbound Nanespace — specify the inbound namespace or accept the default. This is
currently not validated.
e CQutbound Nanespace - specify the nanmespace container for messages created by the

out bound converter.
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Note: The default values for this page are taken from the default preference values stored in the
Workbench. You can modify those defaults by visiting the Preference page for the wizard. The process

for modifying the preferences is described in “Appendix B. Modifying COBOL Generator preferences”
on page 70.
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4.1.7 Specifying input and output data structures
Use the third page of the XML Converter wizard to specify the input and output data structures for which
you want to generate the equivalent XML-based interface. In the Input and Output data structure tree
views, select DFHCOMMAREA as input and output structure. (Fig. 8)

# Generate XML converter Wizard El

Data structures

Select the input and output data stroctures @

The input and output data skructures have been imported from the language file.
Select the input and ouktpuk daka skruckures For use as input and oukput XML messages.

Input data struckure:

#-[] ® SOL-MESSAGE |
B[] ® SQLERROR
F-[] ® soLsTAT
B[] ® SQLERRORP
-] ® ABEND-MESSAGE
=[] ® Hv-DATA
=-[#] ® DFHCOMMARES
[ ® CUSTHNO
® ACCTNO
.[7] ® BALANCE |
-

Cukput data struckure:

#-[] ® SOL-MESSAGE |
B[] ® SQLERROR
F-[] ® soLsTAT
B[] ® SQLERRORP
-] ® ABEND-MESSAGE
=[] ® Hv-DATA
=-[#] ® DFHCOMMARES
® CUSTHO
® ACCTNO
@ BALANCE |
-

........ {:Eack ......... Mext - | IE"_ITI ancel

Figure 8, Data Structure Selection

On this page, the fields are as follows:

e lnput data structure — select the level 01 data from an available list of |level 01
COBOL data structures extracted from your existing application program This data
structure will be used to generate i nbound XML converters.

e (Qutput data structure — sanme as above but used to generate outbound XM. converters.

Note: Some of the attributes for COBOL data items and their treatment by the generated converters
depend on COBOL compiler options. An example of such options is the TRUNC(BIN) option that causes
the zZOS COBOL compiler to treat all binary items as if they all were native binary items. You can
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modify these options using the COBOL Importer preference page. To get to this page, click the “override
importer options” button on the generation options page in the wizard. The options set during the wizard
session do not persist beyond the current session. To permanently modify the importer preferences refer
to Appendix C. Modifying COBOL Importer preferences on page 72.
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4.1.8 Generating code
Press Finish to complete the generation process. After the wizard processing completes, you will notice
that your Converter and Driver files are generated and displayed in the Navigator view. (Fig. 9)

4 Resource - ACTDCNVLchI - 1BM WebSphere Studio Enterprise Developer 1Ol x|

File Edit MNavigate Search Project Run  Window Help

IS -BRa[ & -[|s|ce-2-[|as|amr|A
=1 T3 Navigator — w X || i]Welcome [a Xl
I% & | o Row 1 Column 1 Insert
E-aF XML Account Test - E— e — C—— i — e — e —— L In—
a ACTDCMNVI.chl I Frocess nodynam, opt,codepage (1140) , nsymbol (DBCS) ,r_cc;csﬂ
a ACTDCNYVO. bl Process arith(extend)
{§] ACTDDRYV.cbl * L T T T T
&) DFHOACTD. bl * R T e T P T ST T P T T LTS
[S) DFHOACTDL xsd B R R R R R R R R R R R R R R R R R R R R R R KR R R R R R R R R R R RO R R R R R R R R R R R
.--[8] DFHOACTDO. xs - Inbound XML Converter
4| | » Tdentification Division.

= Program-Id. "RCTDCHVI'. -
gz Outline b « _>|—|

» Identification Division,
Data Division, I
Procedure Division using|
End Program 'ACTDCNVI | |37/ Tasks (0 items) o R e x
Identification Division.
Data Division.
Procedure Division using
‘e End Program "ACTDCMY]

| JI H | Description Resource | In Folder | Locatiol

4| | v 4] |

/05 LPEX Editor is active | | | Flean

Figure 9, Generated Converters and Driver template for DFHOACTD

The inbound converter uses the new Enterprise COBOL language, and specifically, the new XML
PARSE verb to parse XML documents and convert XML into COBOL data:

xml parse a-input-xml (l:a-input-xml-len)

processing procedure a-xml-handler

thru a-general-logic-exit

on exception
perform a-unregister-exception-handler
perform a-signal-condition

not on exception
perform a-unregister-exception-handler
move zero to a-converter-return-code
end-xml

The outbound converter converts the output COBOL data from the existing program into an output XML
message:

move CUSTNO 5 pic x(8) wvalue
of DFHCOMMAREA '<custno>"'.
to ¢c-CUSTNO-0 5 ¢-CUSTNO-0 pic -9(5)
of c-xml-response value zeros.
5 pic x(9) value
'</custno>"'.
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4.1.9 Generating additional converters
Use the XML Converter wizard as described previously to generate Converters and Driver template for

DFHOCSTD. Notice that Converter and Driver files were generated and displayed in the Navigator view.

(Fig. 10)
4 Resource - Welcome - IBM WebSphere Studio Enterprise Developer -|0O] x|
File Edit Mavigate Search Project Run Window Help
|IH-BRE|B|®-]| ]l c-3 -
B || 22 Navigatr w x ﬁ] 5] ACTDCNVL. cbl
== & « | = ||WebSphere Studio Enterprise Developer 5.1.2
-l ¥ML Account Test
----- ] ACTDCNYT. chl o , ,
_____ &) ACTDCNVO. chl To start working with IBM WebSphere Studio Enterprise Developer 5,1.2, do as follows:
----- ] ACTDDRY.chl
..... ] CSTDCHVI.chi i3 Launch the help system and read the product overview:
""" a CSTDCHVO.chbl 1. Click Help > Help Contents.
----- ] CSTDORY.chl
----- a DFHOACTD.chl 2. Expand Product Overview, and read the topics included in that category.
----- [3] DFHOACTDLxsd
----- [3] DFHOACTDO.xs
""" 1] DFHOCSTD.chl i3 Read Getting Started content and work through one or more of the tutorials:
----- [S] DFHOCSTDL. xsd
..... @ DFHOCSTDO, 35 1. Under Product Overview, expand Getting Started and select a tutorial,
1| | »
3= Outiine % || 57 Tasks (0items) WD A e x
\n outline is not available. | JI . I Description | Resource | In Folder | Locatio
4 | B

Figure 10, Generated Converters and Driver template for DFHOCSTD

Note: If you will be using Web Services you need to generate ACTDSOAP.cbl and
CSTDSOAP.cbl as your driver programs. The sections on Web Service enablement later in this

paper will assume that you used these names.
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4.1.10 Modifying the CICS converter driver program

You can now modify the converter driver template that was generated by the tool. This is needed to
correctly invoke the inbound converter, the existing application, and the outbound converter using the
EXEC CICS language. The driver template also provides error-handling mechanisms that can be modified
to suit your needs. Modify the mainline section of the ACTDDRYV driver program as follows (the

necessary changes are highlighted in bold):

KA KRR A A AR A AN A A AR A AR A A A A A AR A A A A A A hA A Ak dA A Ak kA kKK
R IR I b b b S b b 2 dh b I dh S b S dh b b db Sh b 2 dh b b S b b e dh b i db b b d dh b b S b b b dh b b dh S b 2 db i 4
R R I b b b dh Sh b 2 db b dh b b S I b b b b IR Sh b g b 2 b b e dh b b 2R b b b dh b b dh b b SR Sh b i db b b db dh b O 4
CICS XML Converter Driver Program
R R I b b I b b I 2 b b b b b I I I I b 2 b I I S I I I b 2 b b b Ih b b 2 b b 2 dh b b 2h b b 2 ah b b 2h b I 2 ah b O 4

KK A AR A KRR A AR A A A A AR A IR AA A A AR A A I A A I AR I A A I AR A AR A Ak A A kA Ak ko kK

b S T T S

BRI e A b I S b S b I S I A b I S R I R S I R S I R S b R S b S b S b S

Identification Division.
Program-Id. 'ACTDDRV'.

Author. WSED.

Date-Written. 8/7/04 11:27 PM.

KK R AR A AR A AR A AR A AR A KA A KRR A AR A AR AR AR A AN A I AR A A A A A A A A A A Ak Ak Ak kh kK

Coded Character Sets Configuration
R R I I b b b dh ah b 2h dh b b 2h b b S ah b 2 2h b b 2 Sh b dh b I 2h b b b dh b b 2h b b db dh b b 2h b b S Sh b 2 2h Sh I db ah b O 4

K R AR A AR A AR A AR A AR A KA A AR A KRR A AR AR A A A A IR A AR A A A A A A A A A A A A Ak Ak Ak kA kA k kK

* Business Program Binary Interface

R S b dh b dh b b 2 eh b Sh b b S Sh b 2 dh b b 2b Sh b 2 Sh b b 2h o b S dh b b dh b b 2 dh b b 2b b b 2 Sh b b dh b b 2b Sh b 2 4h b 4
*01 DFHCOMMAREA

01 BUSINESS-STRUCT

05 CUSTNO PIC S99999
05 ACCTNO PIC S99999
05 BALANCE PIC S9999v99

Linkage Section.
K AR A A A AR A AR A A A A A AR A AR I A AR A AR A A AR A A A A A A A A A A A A dA A A hA A Ak dA Ak kA Ak kK

* New Business Program XML Interface
EEE S dh dh b dh b b 2 ah b Sh b b 2 Sh b 2 dh b b 2b Sh b dh b db e b S dh b b 2b b b 2 dh b 2 2h b b 2 Sh b b dh b b 2h Sh b 2 dh i 4

Procedure Division using DFHCOMMAREA.
Mainline Section.

K
* Enable Exception Handler
K
e
* Execute Current Business Program
K
exec cics link
program ('DFHOACTD')
commarea (BUSINESS-STRUCT)
end-exec
K
* Execute Outbound XML Converter
K e e o
x
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* Finished

exec cics return
end-exec

inbound-conversion.
call "ACTDCNVI'
using
* DFHCOMMAREA
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

outbound-conversion.
call '"ACTDCNVO'
using
* DFHCOMMAREA
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

End Program 'ACTDDRV'.
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Modify the mainline section of the CSTDDRYV driver program as follows (the necessary changes are
highlighted in bold):

KA KRN A A AR A AN A A AR A AR A A A A AR A A A A A A hA A Ak d A Ak kA kKK
R I I b b S b b 2 dh b I dh S b S dh b b IR S b 2 dh b b S b b S b i db b b b b S b b db db b Sh b b db db i 4
R R R I b b b dh b b dh dh b b dh b b S ah b b 2h b b 2 Sh b dh b 2 b b b dh b b 2h b b b dh b 2h b b S Sh b 2 2h b I 2h dh b O 4
CICS XML Converter Driver Program
R R R I b b I S b I 2 b b b b b I e S b b I b b I b I I S b b 2 b b e 2h b b 2 b b I S b b b I 2 Sh b 2 2h b I b ah b O 4

KK A AR A KRR A KA A A A A AA KA AR A AR A A I A A I AR A AR I A A A AR A A A A hA A Ak Ak ko kK

b S T . S

BRI e A b S b I S b I S I A b I S R I R S I R S b S b R S b S b S b

Identification Division.
Program-Id. 'CSTDDRV'.

Author. WSED.

Date-Written. 8/7/04 11:27 PM.

KK R AR A AR A AR A AR A AR A KA AR A A AR A AR AR A A A AR A AR A A A A A A A A A Ak A Ak Ak kh kK

Coded Character Sets Configuration
R R I b b I S b I 2 b b b S b I I b b b I b b I b I I I b b b b b 4h b b 2 b b 2 S b b b b b 2 Sh b b 2h b I b S b 3 4

K AR AR A AR A AR A AR A AR A KA A AR A AR A AR AR A A A I A A A A A A A A A A A A A A A A Ak Ak Ak kA kb k kK

* Business Program Binary Interface

EEE S i I e b I 2 b I e S b I 2 b I b Sh b b b b b b S b b 2h e I e Sh b b dh b b 2 S b b b I b 2 Sh b b ah b I 2h S I b a4
*01 DFHCOMMAREA

01 BUSINESS-STRUCT

05 CUSTNO PIC S99999

05 LASTNAME PIC A (25)

05 FIRSTNAME PIC A(1l5)
05 ADDRESS1 PIC X (20)
05 CITY PIC A(20)
05 STATE PIC A(10)
05 COUNTRY PIC X (15)

Linkage Section.
K AR A A A AR A AR A A A A A AR A A A A A AR A AR I A AR A A AR A A A A A A A Ak dA A A hA A Ak dA Ak kA Ak kK

* New Business Program XML Interface
R S b b i b dh S b 2R ah b db b b S I b 2 dh b b db b b dh b i db b b S dh b b db b b SR S b db b b 2R Sh b b db b b Ib Sh b dh a4

Procedure Division using DFHCOMMAREA.
Mainline Section.

K e
* Enable Exception Handler
K e — e
B
* Execute Current Business Program
K e — e
* exec cics link
* program ('CURRBUS')
* commarea (DFHCOMMAREA)
* end-exec
exec cics link
program ('DFHOCSTD')
commarea (BUSINESS-STRUCT)
end-exec
K e — e —
* Execute Outbound XML Converter
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exec cics return
end-exec

inbound-conversion.
call '"CSTDCNVI'
using
* DFHCOMMAREA
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

outbound-conversion.
call '"CSTDCNVO'
using
* DFHCOMMAREA
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

End Program 'CSTDDRV'.

4.2 Running your XML Enabled application on the mainframe

4.2.1 Preparing your datasets
To set up your XML-enabled application, you allocate the following partitioned data sets then transfer the
associated members. The original sources as well as generated programs are shipped in the
XMLAESMP.ZIP file in Enterprise Developer. You can use the IDE for z/OS tools to transfer the source
files as members to the appropriate datasets on z/OS. Data set characteristics are described in “Setting up
and running the existing business application” on page 7.

a. XML . COBOL
i DFHOACTD"
. DFHOCSTD"
N ACTDCNVI
. ACTDCNVO
N CSTDCNVI
. CSTDCNVO
. ACTDDRV

’ These files/steps are not necessary if you installed and ran the existing application described earlier in this paper (See “Setting up
and running the existing business application” on page 7).
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o oo

XML.

XML.

XML

XML.
XML.

CSTDDRV
XMLEFRNT
CNTL"
DFHSEDB2
DFHSESQL
XMLSCEDA
LOAD"
.OBJECT"
DBRMLIB"
BMS”
XMLMAP

*

*

*

4.2.2 Configuring DB2*

Use the DB2 sample program DSNTIAD (which is shipped with DB2) to create the DB2 tables
“ACCOUNT” and “CUSTOMER” which are needed by the sample programs. Use DFHSEDB2 as a
template for creating the tables. Create the tables by running the DB2 sample program DSNTIAD. The
DSN SYSTEM (...) parameter is the name of your DB2 subsystem. This DB2 should be connected to
your target CICS. You should replace DSTNIAxx with the correct name that corresponds to the release
level of your DB2 subsystem, for example, DSTNIA61 for DB2 6.1. Note that starting with release 6 of
DB2, DSNTIAD is shipped as source and a load module; in prior releases, it is available as source only.
The sample JCL to assemble the DSNTIAD source can be found in DB2.SDSNSAMP(DSNTIJTM) as

one of the steps in the control file:

//SYSTSIN DD *

DSN

RUN PROGRAM (DSNTIAD)

END

//SYSIN

SYSTEM(...)

DD DSN=DFHSEDB2, DISP=SHR

PLAN (DSNTIAXX)
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4.2.3 Assembling BMS maps *
To create the layout of the CICS front end to the sample programs, you assemble the BMS map
XMLMAP using the procedure DFHMAPT supplied with CICS. The resultant COBOL copybook is
referenced in the XMLFRNT program.

4.2.4 Pre-compiling the existing programs *
Since the sample programs contain EXEC SQL statements they must be pre-compiled. Use the DB2 pre-
compiler DSNHPC to pre-compile the sample programs DFHOACTD and DFHOCSTD.

4.2.5 Compiling and link-editing the existing application
Compile and Link-Edit the sample and front end programs DFHOACTD', DFHOCSTD" and XMLFRNT
using the procedure IGYWCL as three separate programs. Be sure to include the CICS compile option.
Ensure that the resulting load modules are in a load data set visible to the CICS RPL.

4.2.6 Compiling and link-editing the XML processing code
Compile and Link-Edit the XML Converter and Converter driver programs ACTDDRV, ACTDCNVI,
ACTDCNVO, CSTDDRYV, CSTDCNVI, CSTDCNVO using the procedure IGYWCL. Link ACTDDRYV,
ACTDCNVI, ACTDCNVO together as one load module with ACTDDRYV as the main program, and
CSTDDRYV, CSTDCNVI, CSTDCNVO together as one load module with CUSTDDRYV as the main
program. Please do not specify the CICS compiler option when building these programs as it is provided
where appropriate in the source.

: These files/steps are not necessary if you installed and ran the existing application described earlier in this paper (See “Setting up
and running the existing business application” on page 7).
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4.2.7 Binding the DB2 tables
To allow the sample programs to access the DB2 tables use the sample DFH$SESQL to perform a DB2
bind for the programs DFHOACTD and DFHOCSTD. The contents of DFHSESQL should be as follows:

DSN SYSTEM ..)

BI ND PACKAGE( EBUSCOL) -
ONKER( TONYF) -
QUALI FI ER( TONYF) -
MEMBER( DFHOCSTD) -
LI BRARY(' TONYF. DBRMLI B. DATA' ) -
ACTI ON(REP) -
| SOLATI ON(CS) -
VALI DATE(BI ND) -
DYNAM CRULES(BI ND) -
ENABLE( Cl CS)

BI ND PACKAGE( EBUSCOL) -
OKER( TONYF) -
QUALI FI ER( TONYF) -
MEMBER( DFHOACTD) -
LI BRARY(' TONYF. DBRMLI B. DATA' ) -
ACTI ON(REP) -
| SOLATI ON(CS) -
VALI DATE(BI ND) -
DYNAM CRULES(BI ND) -
ENABLE( Cl CS)

BI ND PLAN( EBUSPLAN) -
OKER( TONYF) -
QUALI FI ER( TONYF) -
ACTI ON(REP) -
PKLI ST( EBUSCOL. *) -
| SOLATI ON(CS) -
VALI DATE(BI ND) -
DYNAM CRULES(BI ND) -
ENABLE( Cl CS)

END
COW T,

Note that you should use your DB2 subsystem ID as the parameter to the DSN SYSTEM directive. Also
replace the highlighted fields with your system’s high-level qualifier.

4.2.8 Configuring CICS
Define the various resources to CICS. A sample XML$CEDA is provided to assist with this:

® A transaction named XMLF

®* The programs DFHOACTD , DFHOCSTD and XMLEFRNT

¢ The BMS map XMLMAP

® A DB2ENTRY for XMLF that connects it to sample plan EBUSPLAN
® A DB2TRAN for XMLF.

4.2.9 Running the application
To start the application bring up a CICS terminal and run transaction XMLF. The following screen
should appear. Note: the following instructions illustrate transaction 1. The procedure for transaction 2 is
the same.
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/ . _/ |/ NN/ /7 N/ 1
I Lol I NV /LN /L
Il Lo A > < | IN/L T
L L Y L/ N
\ \ \ \ /NN |

PLEASE CHOOSE AN XML ENABLED TRANSACTION:
1. DB2 BANKACCOUNT TABLES FOR THE CUSTOMER DETAILS.
2. DB2 BANKACCOUNT TABLES FOR THE ACCOUNT DETAILS.

ENTER YOUR CHOICE ====>

If you enter 1 as your choice the following will appear on the screen:

|<?xml version="1.0"?><dfhcommarea> <custno>1</custno></dfhcommarea>

The XML document above represents input to the transaction that will retrieve customer information from
a DB2 table. When you press enter the request is executed and the output XML message will appear on
the screen that contains the information retrieved from DB2.

<cbl:dfhcommarea
xmlns:cbl="http://www.DFHOCSTDO.com/schemas/DFHOCSTDOInterface"><custno>1</cu
stno><lastname>WEAVER</lastname><firstname>RICK</firstname><addressl>5 WEST
KIRKWOOD</addressl><city>ROANOKE</city><state>TX</state><country>US</country>
</cbl:dfhcommarea>

4.2.10 Error reporting
The XML Converters are able to report errors. You can verify that by performing the following test.
Clear the terminal screen and run transaction XMLF and select option 1.

When the following screen appears alter one of the XML tags to make the XML document not well
formed then press enter. For example, change the closing “custno” tag to uppercase “CUSTNQO”.

|<?xml version="1.0"?><dfhcommarea> <custno>1l</custno></dfhcommarea>

An XML document containing the error message appears:

<errorResponse><errorOccurred>Y</errorOccurred><errorMessageNumber>280</error
MessageNumber><errorCode>005</errorCode><errorCDATAContentLength>230</errorCD
ATAContentLength><errorMessage> <! [CDATA[IGZ0280S XML to data structure
conversion could not complete in program "CSTDCNVI" because an error return
code of 5 was received from the XML PARSE statement. The error occurred at
element "custno" with the character content
"1".]]1></errorMessage></errorResponse>
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5 Enabling your business application for Web Services

After creating converters and drivers for XML-enabling your application you may want to take your
existing application one step further and expose it as a Web Service. You can use the SOAP for CICS
feature at runtime to deliver XML-based SOAP messages to and from your existing business application.
The diagram below shows the structure of Web Services-enabled applications that we discussed earlier.

Services

Inbound
SOAP

message

Outbound
SOAP

message

\/—

Inbound
SOAP

message [

\/

Outbound
SOAP

message

XML data
I]I:f’| >
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ACTDSOAP

[

XML data

10— >/ | ‘inbounc”
< | | Sonverer
ACTDCNVI

Binary data

Binary data

S ——

Binary data

|:|' > “Outbound”
o Converter
L= | | e

:

XML data

XML data

%

Driver
CSTDSOAP
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Details
DFHOACTD

XML data
XML data

1o “Inbound”
<0 | | Sonverter
) CSTDCNVI

Binary data

Binary data
Binary data
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Details
DFHOCSTD
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Figure 11, Existing Business CICS Application Enabled for Web Services

The rest of section 5 explains how you can use the Enterprise Developer XML Enablement and Web Services tools to
enable and test your application as a Web Service running within the SOAP for CICS environment on z/OS.

5.1 Preparing your application to run as a Web Service on the mainframe

You can now prepare the COBOL converters, drivers and your existing applications to run as

Web Services on the mainframe.

5.1.1 Locating your existing application
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Locate the sources for DFHOACTD and DFHOCSTD on your z/OS system. In order to do that, you can
use IDE for z/OS tools in Enterprise Developer. You define and connect to the remote z/OS system. For
this example, let’s assume that the system you connect to is called STLABE1. Once you are connected to
STLABEI, locate the sources for DFHOACTD and DFHOCSTD. Let’s assume that they are located in a
PDS called XML.COBOL under the high level qualifier (HLQ) TONYF.
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5.1.2 Creating an Enterprise Developer project

Create a local container for the generated XML Converters and the Driver template. This local container
is called “Simple Project”. In Enterprise Developer, switch to the Resource perspective and invoke the

New Project wizard. Select “Simple” as the type of the project you want to create

create a project called “XML Account Test” (Fig. 12.)

‘ﬁ’ Resource - Welcome - IBM Websphere Studio Enterprise Developer
File Edit Mavigate Search Project Run  Window Help

=1ofx|

|F-Baa(8]%-]|d]%e--

Welcome X l

WebSphere Studio Enterprise Developer 5.1.2

To start working with IEM WebSphere Studio Enterprise Developer 5.1.2, do as follows:

@ Launch the help system and read the product overview:
1. Click Help > Help Contents.

2. Expand Product Overview, and raad the topics included in that category.

@ Read Getting Started content and work through one or more of the tutorials:

1. Under Product Overview, expand Getting Started and select a tutorial,

EE Outline x

A0 outling is not available,

%7 Tasks (0 items)

v X

+ | ! | Description Resource
[+t [ peserip

I Locakion

#ML Account Test

Figure 12, XML Account Test Project
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5.1.3 Moving your existing application to Enterprise Developer

Use Copy and Paste operations on the source COBOL files for DFHOACTD and DFHOCSTD to copy
them into your local XML Account Test Project. (Fig. 13) To expand and see the members of the
XML.COBOL PDS (which is represented as a Folder in the Resource perspective) you can click the “+”.

If the source files are located in the local file system on your workstation, use the File > Import operation

provided in the Workbench to import the source files into your local project.

4P Resource - Welcome - IBM WebSphere Studio Enterprise Developer - IEIliI
File Edit Mavigate Search Project Run  ‘Window Help
[ENE A SN
Welcome X l
WebSphere Studio Enterprise Developer 5.1.2
H a DFHBACTD. cbl Tao stark ki ith IBM WebSphere Studio Ent ise Devel 5.1.2, d fall H
‘... DFHOCSTD. cbl o stark working wi ‘ebSphere Studio Enterprise Developer 5.1.2, do as follows:
@ Launch the help system and read the product overview:
1. Click Help = Help Contents.
2. Expand Product Overview, and read the topics included in that category.
(@ Read Getting Started content and work through one or more of the tutorials:
1. Under Product Dverview, expand Getting Started and select a tutorial,
3=/ outline
An outline is not available,
& Tasks (0 items) B = ow X
| Jl . | Descripkion Resource | In Folder | Location

*ML Account Test

Figure 13, XML Account Test Project With Source

Note that the IDE appends extension . cbl to the source file name. This way you can use file type-

specific Enterprise Developer tools like a language-sensitive editor.
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5.1.4 Invoking the XML Converter generator wizard

Invoke XML Converter generator for the source program DFHOACTD.cbl. To do that, select

DFHOACTD.cbl in the Navigator view and invoke the pop-up menu by pressing the right mouse button.
(Fig. 14)

‘ﬂ’ Resource - Welcome - IBM WebSphere Studio Enterprise Developer

=lolx]
File Edit Mavigate Search Project Run Window Help
= ellefl&-]+]l% < -
ﬁ E ko » x || [E)wWelcome X ]
Byl[e = = S WebSphere Studio Enterprise Developer 5.1.2
E-a #ML Account Test
i a DFHOCSTD Mew ¥ b start working with IBM WebSphere Studio Enterprise Developer 5.1.2, do as Follows:
Qpen
Open 'with » B Launch the help system and read the product overview:
Open As
1. Click Help > Help Contents.
] C
o 2. Expand Product Overview, and read the topics included in that category,
é Raste
% Delete
Move i) Read Getting Started content and work through one or more of the tutorials:
Rename 1. Under Product Overview, expand Getting Started and select a butorial,
£ty Impart. ..
£ Export...
Add Bookmark...
a-
= Outline
i $§) Reftesh
An outline is not availak

Run ¥alidation
&H Debug on Server. ..
ﬂ Run on Setver...

@ﬁ Profile on Server... bisks (0 items)
Team 3
Compate ‘With »
Replace With 3

Link Likilities 13

»
»

¥Ry ox
| [ pescription Resource | In Folder | Location |

WEh SErvices

isenerate XML converter...

Properties

Enterprise Services »

%ML Account Test/DFHOACTD.cbl

Figure 14, Invoking the XML Converter generator
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5.1.5 Specifying input and output files for the wizard
Use the first page of the XML Converter wizard to select input and output files for the Converter, Driver
template, and the XML Schema files. Hint: The XML Schema files are automatically generated that
contain the description of the names and types of XML elements. These elements can appear in an XML

document that our program will process and generate. For more information on XML Schema visit
http://www.w3.org/XML/Schema

# Generate XML converter Wizard

File, data set, or member selection

Select the source and targets for the XML converter

Select the source for the XML canverter

x|
Source file or member: I <ML Account Test/DFHOACTD, chl Browse. .. |

Select targets For the XML converter

Converter Folder: I FaML Account Test Browse, .,
Input converter file name: I DFHOACTDI .chl
Output converter File name: I DFHOACTDO .chl
Converter driver fils name: | DFHOACTDD .chl

[~ Generate converters and converter driver to the Input converter File

Select kargets Far the XML Schema

%50 file Folder: | FAML Account Test Browse, ., |

Input message %50 file name: I DFHOACTDI xsd

Output message S0 file name: I DFHOACTDD Lxsd

[~ Cwerwrite files without warning

= Barl I Mext = I Fimish | Cancel

Figure 15, Generate XML Converter Wizard

On this page, the fields are as follows:

. Source file - specify where your existing COBOL program is located

. Converter folders - specify folder(s) where the wizard will generate converter
program(s)

e Converter file names - specify the name(s) you want to give your converter file(s),

e Converter driver file name - specify the name you want to give your converter
driver.

° Generate converters and converter driver to one file - select if you want to

generate the converters and converter driver to the file specified in the “input
converter file name” field. The driver will appear first in the file.

e XSD file folders - specify where the wizard will generate the XML Schema files

e XSD file names - specify the names you want to give your XML Schema files
e Overwrite files without warning - select if you want to overwrite existing output
files
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5.1.6  Specifying the generation options

Use the second page of the XML Converter wizard to specify generation options for your Converter and
Driver programs. Choose the host code page for the Host system were you will deploy the converters.
Choose “CICS SOAP” as the Driver type. There is no need to modify the rest of the specified defaults on
this page. (Fig. 16)

4b Generate XML converter Wizard il

ZML converter options

specify options For the XML converter E7

specify identification attributes

Program name: I KENY

Author name: I WSED

apecify ¥ML corverter driver bype

Drriver type:

Configure XML message processing

Inbound code page: |114I:I U534, Canada, etc, Euro Country Extended j
Host code page: |114IZI L34, Canada, etc, Euro Country Extended j
Outbound code page: |114D 34, Canada, etc., Euro Country Extended j

apecify ¥ML namespaces

Inbound namespace: | http: i v, DFHOACT DI, comy schemas DFHOACTDIT

Outbound namespace: I bkt f e, DFHOACTDO, com) schemas/DFHOAC T

Cwerride Imporker Oplions. .. |

< Back I Texk = I FEirish Cancel

Figure 16, Generation Options Selection

On this page, the fields are as follows:

Program nane - specify the “stenf value for the program nanes in the PROGRAM ID
paragraph of the I DENTIFICATION DIVISION in the COBOL programs that this wizard
will generate. For example, if you enter ACTDCNV, the wzard wll generate
ACTDCNVI  for the inbound converter program nanme, ACTDCNVO for the outbound
converter, and ACTDCNVD for the converter driver.

Aut hor name — specify the value for the AUTHOR paragraph

Driver type — specify the desired driver type. Choose “CICS’. The CICS driver type
provi des sone conveniences to mnimze the need for nodifications.

Maxi rum nessage size — specify the naxi num size of the XM. message that will need
to be allocated when processing and generating the XM. nessage.

Code pages - specify code page(s) for the encoding of the inbound and out bound XM
docunents, and the code page for the host data.

I nbound Nanespace - specify the inbound namespace or accept the default. This is
currently not validated.

Qut bound Nanmespace — specify the namespace container for nessages created by the
out bound converter.
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Note: The default values for this page are taken from the default preference values stored in the
Workbench. You can modify those defaults by visiting the Preference page for the wizard. The process

for modifying the preferences is described in “Appendix B. Modifying COBOL Generator preferences”
on page 70.
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5.1.7 Specifying input and output data structures
Use the third page of the XML Converter wizard to specify the input and output data structures for which
you want to generate the equivalent XML-based interface. From the two pull-down combo boxes, select
DFHCOMMAREA as both input and output structure. (Fig. 17)

# Generate XML converter Wizard El

Data structures

Select the input and output data stroctures @

The input and output data skructures have been imported from the language file.
Select the input and ouktpuk daka skruckures For use as input and oukput XML messages.

Input data struckure:

#-[] ® SOL-MESSAGE |
B[] ® SQLERROR
F-[] ® soLsTAT
B[] ® SQLERRORP
-] ® ABEND-MESSAGE
=[] ® Hv-DATA
=-[#] ® DFHCOMMARES
[ ® CUSTHNO
® ACCTNO
.[7] ® BALANCE |
-

Cukput data struckure:

#-[] ® SOL-MESSAGE |
B[] ® SQLERROR
F-[] ® soLsTAT
B[] ® SQLERRORP
-] ® ABEND-MESSAGE
=[] ® Hv-DATA
=-[#] ® DFHCOMMARES
® CUSTHO
® ACCTNO
@ BALANCE |
-

........ {:Eack ......... Mext - | IE"_ITI ancel

Figure 17, Data Structure Selection

On this page, the fields are as follows:

e lnput data structure — select the level 01 data from an available list of |level 01
COBOL data structures extracted from your existing application program This data
structure will be used to generate i nbound XML converters.

e (Qutput data structure — sanme as above but used to generate outbound XM. converters.

Note: Some of the attributes for COBOL data items and their treatment by the generated converters
depend on COBOL compiler options. An example of such options is the TRUNC(BIN) option that causes
the zZOS COBOL compiler to treat all binary items as if they all were native binary items. You can
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modify these options using the COBOL Importer preference page. To access this page, click the “override
importer options” button on the generation options page in the wizard. The options set during the wizard
session do not persist beyond the current session. To permanently modify the importer preferences refer
to Appendix C. Modifying COBOL Importer preferences on page 72.
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5.1.8 Generating code
Press Finish to complete the generation process. After the wizard processing completes, you will notice
that your Converter and Driver files are generated and displayed in the Navigator view. (Fig. 18)

@ Basic JCA - ACTSOAPI chl - IBM WebSphere Studio Enterprise Developer MEE
File Edt Navigate Search Project Run Window Help
IS-ERa|sadn] Jolaflts-* -%-[oaFc- & -
|| I8 package Exlorer - x S0APlck
& | = &
,@ E-la# XML Accourt Test
"2 L) ACTDSOAP.H E
i ACTSDAP cbl
+-f5) ACTSOAPO chl Identification Division.
a DFHOACTD.cbl Program-TId. "ACTDCNVI'.
+-[8] DFHOACTDIxsd Ruthor. WSED.
@ DFHOACTDO xsd Date-Written. 3/26/04 12:08 PM.
-f@] DFHOCSTD cbl Data Division.
Working-Storage Section.
1 a-xml-root-element.
2 pic x(11) wvalue
"dfhcommarea” .
1 a-element-hash-entries.
2 a-ehe-0.
3 pic x(7) value
"acctno’'. id|
Find |cuslno ﬂadl Previous | All
Replace | Replace | Replace all
I™ Case senstive [~ Regularexpression W Wrap [ Selectfoundtext [ Restrict search to selection
Package Eq)\ore(JJZEE Hierarchy ™ Restrict searchto columns  Start column |1 End column |80
HE Outine X || 57 Tasks [Ditems) o 2 e x
Identification Division. ACTDCNVT, |+ * [ Descrigtion | Resource | In Folder | Location_|
- Data Division
Procedure Division using
- End Program "ACTDCNVI'
Idertification Division. 'ACTDCNVN'.
- Data Division
Procedure Division using a-cument-condition a-]
- End Program "ACTDCNWN'
4| | v||Tasks ISewer Corfiguration | Servers | Console | Properties
2/05 LPEX Edtor is active | | | Flean

i stan| (& 5 » deel | Da g [@w | |ake |@ar (e | Q2s-|[Ge M > |_99% bk |« [F][[]% @& 1227F0
Figure 18, Generated Converters and Driver template for DFHOACTD

The inbound converter uses the new Enterprise COBOL language, and specifically, the new XML
PARSE verb to parse XML documents and convert XML into COBOL data:

xml parse a-input-xml (l:a-input-xml-len)

processing procedure a-xml-handler

thru a-general-logic-exit

on exception
perform a-unregister-exception-handler
perform a-signal-condition

not on exception
perform a-unregister-exception-handler
move zero to a-converter-return-code

end-xml

The outbound converter converts the output COBOL data from the existing program into an output XML
message:

move CUSTNO 5 pic x(8) wvalue
of DFHCOMMAREA '<custno>"'.
to ¢-CUSTNO-0 5 ¢-CUSTNO-0 pic -9(5)
of c-xml-response value zeros.
5 pic x(9) value
'</custno>"'.
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5.1.9 Generating additional converters
Use the XML Converter wizard as described in steps above to generate Converters and Driver template
for DFHOCSTD. Notice that Converter and Driver files were generated and displayed in the Navigator
view. (Fig. 19)

‘#’ Resource - Welcome - IBM WebSphere Studio Enterprise Developer — |E| |1|
File Edit Mavigate Search Project Run  Window Help

IENERIEA T -
+ % || [E]welcome Xl

WebSphere Studio Enterprise Developer 5.1.2

=] ACTDSOAR, cbl

_____ a ACTSOAPL cbl To start working with IBM Websphere Studio Enterprise Developer 5.1.2, do as follows:
----- 1m] ACTSOAPO.chl
..... 8] CSTDS0AP.chl @ Launch the help system and read the product overview:

----- 18] CSTSOAPL.chl
----- m] CSTSOAPO . cbl
""" 18] DFHOACTD.chl 2. Expand Product Overview, and read the topics included in that categary.
----- [S] DFHOACTDI. xsd
----- [S] DFHOACTDO.xsd

1. Click. Help = Help Contents.

""" 18] DFHOCSTD. bl @ Read Getting Started content and work through one or more of the tutorials:
----- [S] DFHOCSTDL. xsd
..... [8] DFHOCSTDO. xsd L. Under Product Overview, expand Getting Started and select a tutorial,

3= Outline X

a0 outline is nak available,

i+ | Tasks {0 items) G 2 - x

| J’I ! | Description | Resource | In Folder | Location |

ML Account Test

Figure 19, Generated Converters and Driver template for DFHOCSTD

5.1.10 Modifying the CICS SOAP converter driver programs
You can modify the converter driver template that was generated by the tool. This is needed to correctly
invoke the inbound converter, the existing application, and the outbound converter using the SOAP for
CICS features. The driver template also provides error-handling mechanisms and BTS activity that can be
modified to suit your needs. Modify the mainline section of the ACTDSOAP driver program as follows
(the necessary changes are highlighted in bold):

LR R I b b e I b I 2 b b b b b I I b b b 2h A I b b b dh b I b S b b 2h b b Sh b b 4 e
R R IR I 2 A b 2 dh I b 2 dh b b dh I b S db b b dh Ib b 2h 3b b b I Ib b 2 db b i 2R Ib b dR db I i dh db b db db b b SR Ib b db db b 4
R R IR A b b dh A Sh b 2 db b dh b b S S b db b b R Sh b dh b 2 b b e db b b SR b b b db b dh b b R Sh b i db b b db dh b O 4
CICS XML Converter Driver Program
R I I b b I b b I 2 b b b 2 b b I b I b Ih b b 2 b I b a2 b b b Ih b b 2 b b 2 S b b b b 2 Sh b b 2h b I 2 ah b 3 4

KK A AR A KRR A AR A KA A A A A A IR AA A A A I A A I A A I AR A AR I AR A AR A Ak A A A Ak Ak kK

b S T e

BRI e A b S b S b I I b I A b I S B R S I S S S b R S b e S b S b S
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*

*

*

*

*

*

*

X % % o

Identification Division.
Program-Id. 'ACTDSOAP'.
Author. WSED.

Date-Written. 8/7/04 11:27 PM.

KA KR AR R AR A AR A AR A AR AR KR AR KR A AR A AR A AR A AR A A A A A A A A A A kA A kA Ak Ak hkk kA hkkhx %k

Coded Character Sets Configuration
KA AR A A A AR A AR A A AR A AR A A A A A AR A A A A A A A A A A A A A A A A hA A A A A Ak hA Ak h A Aok k ko kK

KA KR AR R AR A AR A AR A AR A AR AR KR A AR A AR A AR A AR A A A A A A Ak A A kA Ak Ak kA Ak k kA khx %k

Business Program Binary Interface
R R I A A b AR Ib b 2 db b b dh S b S db b S db I b 2R Ib b b 4 I 2 I b d db I b 2R b b b A b b dh Ib b dR db b i db Ib b db db b 4
01 DFHCOMMAREA
01 BUSINESS-STRUCT

05 CUSTNO PIC S99999
05 ACCTNO PIC 599999
05 BALANCE PIC S9999v99

KK KR AR A AR A AR A AR A AR A AR A KRR A A A AN A AN A AR A AR A AR A AR A A A A A A A A A A kA kA ko kK

CICS SOAP BTS

KA KR AR R AR A AR A AR A AR A AR AR KR A AR A AR A AR A AR A A A A A A Ak A Ak A A kA Ak Ak k kA kh k%

KK KR AR A AR A AR A AR A KRR A KRR A KRR A AR A A A AR A A A A A A I AR A A A A A A A A A A A Ak Ak Ak k Kk kK

New Business Program XML Interface
R e I b b b dh b b 2 dh b Sh b b S Sh b 2 2h b b 2R Sh b dh b I 2h b b b dh b b 2 b b b dh b 2h b b 2 Sh b 2 2h Sh I 2 dh b O 4

PROCEDURE DIVISION.
MAINLINE SECTION.

exec cics link

program ('CURRBUS')
commarea (DFHCOMMAREA)
end-exec

exec cics link

program ('DFHOACTD')
commarea (BUSINESS-STRUCT)
end-exec

exec cics return
end-exec
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inbound-conversion.
call '"ACTSOAPI'
using
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

outbound-conversion.
call '"ACTSOAPO'
using
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

End Program 'ACTDSOAP'.

46 Providing a Web Services Interface To a CICS Application
© Copyright IBM Corporation 2002, 2004. All Rights Reserved.




Modify the mainline section of the CSTDSOAP driver program as follows (the necessary changes are
highlighted in bold):

KA KRN A A AR A AN A A AR A AR A A A A AR A A A A A A hA A Ak d A Ak kA kKK
R I I b b S b b 2 dh b I dh S b S dh b b IR S b 2 dh b b S b b S b i db b b b b S b b db db b Sh b b db db i 4
R R R I b b b dh b b dh dh b b dh b b S ah b b 2h b b 2 Sh b dh b 2 b b b dh b b 2h b b b dh b 2h b b S Sh b 2 2h b I 2h dh b O 4
CICS XML Converter Driver Program
R R R I b b I S b I 2 b b b b b I e S b b I b b I b I I S b b 2 b b e 2h b b 2 b b I S b b b I 2 Sh b 2 2h b I b ah b O 4

KK A AR A KRR A KA A A A A AA KA AR A AR A A I A A I AR A AR I A A A AR A A A A hA A Ak Ak ko kK

b S T . S

BRI e A b S b I S b I S I A b I S R I R S I R S b S b R S b S b S b

Identification Division.
Program-Id. 'CSTDSOAP'.
Author. WSED.

Date-Written. 8/7/04 11:27 PM.

KK R AR A AR A AR A AR A AR A KA AR A A AR A AR AR A A A AR A AR A A A A A A A A A Ak A Ak Ak kh kK

Coded Character Sets Configuration
R R I b b I S b I 2 b b b S b I I b b b I b b I b I I I b b b b b 4h b b 2 b b 2 S b b b b b 2 Sh b b 2h b I b S b 3 4

K AR AR A AR A AR A AR A AR A KA A AR A AR A AR AR A A A I A A A A A A A A A A A A A A A A Ak Ak Ak kA kb k kK

* Business Program Binary Interface

EEE S i I e b I 2 b I e S b I 2 b I b Sh b b b b b b S b b 2h e I e Sh b b dh b b 2 S b b b I b 2 Sh b b ah b I 2h S I b a4
*01 DFHCOMMAREA

01 BUSINESS-STRUCT

05 CUSTNO PIC S99999

05 LASTNAME PIC A (25)

05 FIRSTNAME PIC A(15)

05 ADDRESS1  PIC X(20)

05 CITY PIC A(20)

05 STATE PIC A(10)

05 COUNTRY PIC X (15) .

EEE S I i I I b I 2 b I e S b b 2 b I b Ih b b b b I b b b b b e b e Sh b b dh b b 2 S b b b b I 2 b b b Sh b I 2h S I b a4
* CICS SOAP BTS

K AR A A A A A AR A KA A A A A A KA A A A A A A A A AR A AR A AR A AR A A I A A A A I AR A AR A AR A Ak kA hx

LR i b b I A b I S b I S b I S b I S b S S S b e S R S I I S b e S b S b I S b I S R S S b S b R S Sh S b S i

New Business Program XML Interface
K AR A AR A A A A A KR A A A A A IR A A A A A A A A A AR A AR A AR A A I A A I A A A A I AR A AR A AR A Ak kA hx

Procedure Division.
Mainline Section.

exec cics link

program ('DFHOCSTD')
commarea (BUSINESS-STRUCT)
end-exec
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exec cics return
end-exec

inbound-conversion.
call '"CSTSOAPI'
using
* DFHCOMMAREA
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

outbound-conversion.
call '"CSTSOAPO'
using
* DFHCOMMAREA
BUSINESS-STRUCT
xml-int-len
xml-int-txt
omitted
* optional-feedback-code
returning
converter-return-code

End Program 'CSTDSOAP'.

5.1.11 Preparing your datasets
To set up your Web-enabled application, you allocate the following partitioned data sets then transfer the
associated members. The original sources as well as generated programs are shipped in the
XMLA4ESMP.ZIP file in Enterprise Developer. You can use the IDE for z/OS tools to transfer the source
files as members to the appropriate datasets on z/OS. Data set characteristics are described in “Setting up
and running the existing business application” on page 7.

a. XML . COBOL
. DFHOACTD"
o DFHOCSTD"
. ACTSOAPI
o ACTSOAPO
. CSTSOAPI
N CSTSOAPO
. ACTDSOAP

’ These files/steps are not necessary if you installed and ran the existing application described earlier in this paper (See “Setting up
and running the existing business application” on page 7).

48 Providing a Web Services Interface To a CICS Application
© Copyright IBM Corporation 2002, 2004. All Rights Reserved.




N CSTDSOAP
b. XML.CNTL"
o DFHSEDB2
. DFHS$SESQL
o XMLS$CEDA
XML .LOAD"
XML .OBJECT"
XML .DBRMLIB"

XML .BMS
e XMLMAP

*

*

*

o oo

5.1.12 Configuring DB2*
Use the DB2 sample program DSNTIAD (which is shipped with DB2) to create the DB2 tables
“ACCOUNT” and “CUSTOMER” which are needed by the sample programs. Use DFHSEDB2 as a
template for creating the tables. Create the tables by running the DB2 sample program DSNTIAD. The
DSN SYSTEM (...) parameter is the name of your DB2 subsystem. This DB2 should be connected to
your target CICS. You should replace DSTNIAxx with the correct name that corresponds to the release
level of your DB2 subsystem, for example, DSTNIA61 for DB2 6.1. Note that starting with release 6 of
DB2, DSNTIAD is shipped as source and a load module; in prior releases, it is available as source only.
The sample JCL to assemble the DSNTIAD source can be found in DB2.SDSNSAMP(DSNTIJTM) as
one of the steps in the control file:

//SYSTSIN DD *
DSN SYSTEM(...)
RUN PROGRAM (DSNTIAD) PLAN (DSNTIAXX)
END

//SYSIN DD DSN=DFHS$EDB2, DISP=SHR
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5.1.13 Pre-compiling the existing programs”
Since the sample programs contain EXEC SQL statements they must be pre-compiled. Use the DB2 pre-
compiler DSNHPC to pre-compile the sample programs DFHOACTD and DFHOCSTD.

5.1.14 Compiling and link-editing the existing application”
Compile and Link-Edit the sample and front end programs DFHOACTD', DFHOCSTD" and XMLFRNT"
using the procedure IGYWCL. Be sure to include the CICS compile option. Ensure that the resulting
load modules are in a load data set visible to the CICS RPL.

5.1.15 Compiling and link-editing the XML processing code
Compile and Link-Edit the XML Converter and Converter driver programs ACTDSOAP, ACTDCNVI,
ACTDCNVO, CSTDSOAP, CSTDCNVI, CSTDCNVO using the procedure IGYWCL. Link
ACTDSOAP, ACTDCNVI, ACTDCNVO together as one load module with ACTDSOAP as the main
program, and CSTDSOAP, CSTDCNVI, CSTDCNVO together as one load module with CSTDSOAP as
the main program. Please do not specify the CICS compiler option when building these programs as it is
provided where appropriate in the source.

: These files/steps are not necessary if you installed and ran the existing application described earlier in this paper (See “Setting up
and running the existing business application” on page 7).
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5.1.16 Binding the DB2 tables
To allow the sample programs to access the DB2 tables use the sample DFH$SESQL to perform a DB2
bind for the programs DFHOACTD and DFHOCSTD. The contents of DFHSESQL should be as follows:

DSN SYSTEM ..)

BI ND PACKAGE( EBUSCOL) -
ONKER( TONYF) -
QUALI FI ER( TONYF) -
MEMBER( DFHOCSTD) -
LI BRARY(' TONYF. DBRMLI B. DATA' ) -
ACTI ON(REP) -
| SOLATI ON(CS) -
VALI DATE(BI ND) -
DYNAM CRULES(BI ND) -
ENABLE( Cl CS)

BI ND PACKAGE( EBUSCOL) -
OKER( TONYF) -
QUALI FI ER( TONYF) -
MEMBER( DFHOACTD) -
LI BRARY(' TONYF. DBRMLI B. DATA' ) -
ACTI ON(REP) -
| SOLATI ON(CS) -
VALI DATE(BI ND) -
DYNAM CRULES(BI ND) -
ENABLE( Cl CS)

BI ND PLAN( EBUSPLAN) -
OKER( TONYF) -
QUALI FI ER( TONYF) -
ACTI ON(REP) -
PKLI ST( EBUSCOL. *) -
| SOLATI ON(CS) -
VALI DATE(BI ND) -
DYNAM CRULES(BI ND) -
ENABLE( Cl CS)

END
COW T,

Note that you should use your DB2 subsystem ID as the parameter to the DSN SYSTEM directive. Also
replace the highlighted fields with your system’s high-level qualifier.

5.1.17 Configuring CICS

Define the various resources to CICS. A sample XMLSCEDA is provided to assist with this:

® A transaction named XMLS

® The programs DFHOACTD , DFHOCSTD, CUSTDSOAP and ACTDSOAP

®* A DB2ENTRY for XMLF that connects it to sample plan EBUSPLAN
® A DB2TRAN for XMLS.
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5.2 Creating a SOAP-Based Web Service client for an Enterprise Application

In the previous sections, you created XML converters and an XML Schemas (XSD) for inbound and
outbound messages (for example, DFHOACTDI.xsd for inbound and DFHOACTDO.xsd for outbound).

Now, let’s create a Web Services description for the Account details service. This service is already
implemented! Surprised? Don’t be! Your XML enabled business application described in the previous
sections is the implementation of your web service. The only thing left to do is to describe that service to
the Web services world.

WSDL or Web Service Description language is an XML format for describing network services. It
provides a description of the service, consumable in many other technologies (such as in Enterprise
Developer to generate Java' code to drive the service) or UDDI to publish the service to other
organizations.

The definition includes the thought of considering services as a set of endpoints operating on messages.
The operations and/or procedures contained in these services are first described in an abstract manner,
then bound to a specific network, transport protocol and message format.

WSDL is based on other technologies such as XML schemas and XML namespaces. WSDL provides a
description not only of the service, but also of the messages the service can accept and generate.

You will use the Web Services New WSDL wizard. To run it, select File > New > Other > Web Services
> WSDL. The following Wizard appears:

4k New WSDL File x|

New WSDL File
Create a new W3DL File

Enter or select the parent: folder:

I ML Account Test

&

1o EML Sccount Tesk

File name: | =

< Back | fext = | Einish I Cancel

Figure 20, New WSDL File Wizard
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Name your WSDL (For example, DFHOACTD.wsdl), click Next and the following page appears:
4B New WSDL File x|

Options

Specify the attributes For the new WSDL File,

Target Mamespace: | http: i fexample.com

Prefiz: | tns

Definition name: I Marne

—Mamespace URIs ko be included

Select I Prefix I Mamespace Mame I

<

wsd| http: /fschemas. xmisoap. orgfwsdly

508 http: fischemas. xmisoap.orgiwsdlfsoap)

O hktp http:/fschemas xmisoap, of giwsdiihttp)

O i http:/fschemas xmlsoap, of gfwsdlimime,

O SOAPENC http:/fschemas xmlsoap. of gfsoapfencoding
SOAPEnNY http:/fschemas xmlsoap. of gfsoapfenvelope)
O w5 htkp: i, w3, org /2001 (=ML Schema-instance
wsd htkp: | i, w3, org 2001 =ML Schema

< Back. | Text = | Einish I Cancel

Figure 21, Specifying New WSDL File Options

You can also give your WSDL a name; for example, AcctDetail Wsdl.

Namespaces are external locations that contain definitions for various parts of the WSDL we are defining

— including the elements, attributes, and types. These definitions define various parameters including
SOAP (protocol) and Envelope (data or payload).

Type the name into the Definition Name field. Make sure to select soap and soapenv namespace URIs,
and click Finish.
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The new WSDL file is created and added to your project:

@’ Resource - DFHOACTD.wsdl - IBM WebSphere Studio Enterprise Developer = |E| 5‘
File Edt Mavigate Search Project Run  WSDLEditor MWindow Help

IS -HRallg]|%-|2]ce->-aa0d[@as s
E 5. Mavigator v x || ] Welcome X}

’% I <%¥ml version="1.0" encoding="UTF-5"7> =]
=12 ¥MIL Accounk Test <wsdl:definitions name="icctDetallWsdl™
B a [Pp— targetlamespace="http://exarnple. com™
wmlns:tns="http://example.com"

xmlns:wsdl="http://schenas. xwlsoap.org/ vsdl/ ™
umlns:soap="http://schenas. xmlsoap . org/ usdl/ soap/
xmlns:soapenv="http://schemas.xmlsoap.ory/ soap/ em
xmlns:xsd="http://wrw.w3.org/ 2001/ EHLSchema ™

</wsdl:definitionss

i-fm) DFHOACTDL.chl
i8] DFHOACTDLxsd
-] DFHDACTDO. chl
i [8] DFHOACTDO  xsd

8= outine X
~{a1 Imports

- Types

H % Messages

-2 Extensiblity Elements

B

4
Source | Graph

| &7 Tasks @icems) ¥ B3P~ x
| Tasks JConsoIe

Writable Insert 1:1

Figure 22, New WSDL file

Now switch to the “Graph” view of the WSDL source.

‘ﬁ? Resource - DFHOACTD.wsdl - IBM WebSphere Studio Enterprise Developer - |EI|£|
File Edit Mavigate Search Project Run  WSDLEditor  wWindow Help

|Is-BR&[8|%-||s|ee-=-]A8002% %
E 5. Mavigator w ¥ || | welcome o x]
[yl & m | = 5 S
[El-1a$ ¥ML Account Test N
] DFHOACTD.chl 1=

@] DFHOACTD wsdl Definition
18] DFHOACTDD, ol
@] DFHOACTDL.chl Imparts Types
[S] DFHOACTDL.xsd
- f] DFHOACTDO cbl
" [§] DFHOACTDO. xsd

Services Bindings Pork Types Messages -

:E Outline b4

{1 Imports hd
1 | 3

Documentation l

B
Saource IGraph]
% Tasks (0 items) S5 }:9 - x

Tasks J Console

it able Insert 1:1

Figure 23, Graph View of WSDL Source

Fill in the additional details in WSDL definition needed to complete the service.

Above we discussed web services and messages contained therein. Messages are logically grouped to
operations that are logically grouped to port types. You’ll start the process then by defining a Port Type.

Create a Port Type for your service: Right-click on the “Port Type” section in the Graph view, then select
Add Child > portType. The following dialog appears:
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4P New PortType x|

oK I Cancel |

Figure 24, New Port Type Dialog

Type your port type name in this dialog (for example, AcctDetailPortType) and click OK.
AcctDetailPortType entry is created in the Port Types section.

Now create an Operation for the Port Type. Operations represent a unit of work and also can be looked
on as representing an endpoint, such as our CICS program(s) or service(s). Each operation is composed
of messages, for example input and output messages.

Right-click on AcctDetailPortType then select Add child > operation. The following dialog appears:

4k New Operation x|

K I Cancel |

Figure 25, New Operation Dialog

Type your operation name in this dialog (for example, AcctDetailOperation) and click OK.
AcctDetailOperation entry is created under AcctDetailPortType in the Port Types section:
Poart Types
= i AcctDetailPortType

% AcckDetalOperation

Figure 26, Port Types Section

Now, in the Messages section, create a message to be used with your AcctDetailOperation. The message

will have two parts. A request part (or input) and a response part (or output). Right mouse click on the
“Messages” section in the Graph view then select Add Child > message. The following dialog appears:
]

‘ﬁ* New Message

K I Cancel |

Figure 27, New Message Dialog

Type your message name in this dialog (for example, AcctDetailMessage) and click OK.
AcctDetailMessage is created in the Messages section.

Now create message parts. Right mouse click on AcctDetailMessage then select
Add child > part. The following dialog appears:
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oK I Cancel |

Figure 28, New Part Dialog

Type your part name in this dialog (for example, AcctDetailRequest) and click OK.
AcctDetailRequest part is created under AcctDetailMessage in the Messages section:
Messages

E ] AcctDetailMessage

I AcctDetailRequest

Figure 29, Messages Section

Note that the part is initially created with a type of xsd:string. We will change that a bit later.
Next create a AcctDetailResponse part for your message the same way as you created AcctDetailRequest:
Messages

E ] AcctDetailMessage
[P AcctDetailRequest (esd:string)

I AcctDetailResponse (xsdistring)

Figure 30, Messages Section with Additional Part

Next, you will need to define the message parts according to the XML Schema types derived from the
COBOL data structures. Use the XML Schema(s) or XSD(s) that define the message (inbound and
outbound). In some cases the schema will be the same, in some it will differ between input and output.
To do that, in the Message section, right mouse click on the AcctDetailRequest. Then in the action menu,
click Set Element... action. The following dialog appears:

specify Element

Specify Element

Provide a name of the element to create

¥ Create a new element
" Select an existing element

™ Import element from a file

MName of element: | S=EIELS

Finish I Cancel

Figure 31, Specify Element Dialog
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Select the Import element from a file radio button.
The dialog will change to the following:

Specify Element

Specify Element

Select a file and then choose the element

" Create a new element
™ Select an existing element

' Import element From a File

File: I Browse, .. |

¥ Use WS- style schema import

Eiriish I Zancel

Figure 32, Specify Element Dialog with Import Option Selected

Click Browse.

select File
I,
Select a WSDL or X5D file to import .

Workbench Files

=-1aF XML Account Test
@) DFHOACTD wsdl
SR O FHOAC DI xsd
-[8] DFHOACTDO xsd
--[8] DFHOCSTDIxsd
- [8] DFHOCSTDO xsd

Import Files... |
QK I Cancel

Figure 33, Importing an Element

In the File selection dialog that follows, navigate to the XSD file that was produced from the COBOL
inbound structure, for example DFHOACTDI.xsd.

Providing a Web Services Interface To a CICS Application
© Copyright IBM Corporation 2002, 2004. All Rights Reserved.



Click OK in the File selection dialog and the following will appear in the Type selection:

Specify Element

Specify Element
Select & file and then choose the element

" Create a new element
" Select an existing element

% Import element from a Fil

File: I J¥ML Account Test/DFHOACTDL. xsd iBrowse.. . i

W Use ws-1 style schema import

Finish I Cancel

Figure 34, Completing Element Specification

Select DFHCOMMAREA. Also make sure that Use WS-I style schema import is checked. Click
Finish.

Use the same process to set the response part element, but when selecting the XSD file, choose the
outbound XSD, for example, DFHOACTDO.xsd.
At the end of specifying part elements, the Messages section will look like this:

Messages

E ] AcctDetailMessage
¥ AcctDetaiRequest (xsd 1:DFHCOMMAREA)

P AcctDetailResponse (xsd2:DFHCOMMAREA)

Figure 35, Messages Section Showing an External Element Reference
Note that the shadowed rectangle pointed to by the arrow indicates an external element reference.

Up until this point, everything you’ve done logically defines the service. Now you will begin the process
of binding your operation to the protocol and to the physical endpoints.

A port ties your message to a protocol-specific address and/or network endpoints.

Now create input and output parameters for your operation. In the Port Types section, right mouse click
on AcctDetailOperation then select Add child > input. Do the same for output. “input” and “output”
parameters are created under AcctDetailOperation in the Port Types section:
Park Types
El [l AcckDetailPortType
[l &8 AcctDetailoperation
[ input
il output

Figure 36, Port Types Section Showing Input and Output Parameters
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You will associate a message from the Messages section with the input and output parameters for your
operation. You can use either the context menu action, Set message, or the Input editor section. Let’s use
the Input editor:

Input

Mame

Message El _I

Figure 37, Input Editor
In the Name entry enter, for example, AcctDetailOperationlnput.

In the Message entry, click on the combo box arrow pull-down and select the Message that we created
earlier:

Input

TMarre AcctDetalOperationInput

Message - _I

tnzdcctDetaiessags...............

aurce | Grag

Figure 38, Input Editor Message Selection

Repeat the same for the output parameter, but enter for example, AcctDetailOperationOutput as output
parameter name.

Next you will create a binding for your Port Type. This completes the protocol/endpoint definition
mapping the logical service to the physical endpoints.

To create a binding right mouse click on the Binding section of the WSDL editor and select
Add Child->Binding:

Bindings Prrt Tvnes

Add Child » :_] Einding

Figure 39, Binding Wizard Toolbar Icon

The Binding wizard appears:
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4F Binding Wizard

Specify Binding Details
Specify the details of the binding that will be created

Figure 40, Generate Binding Wizard
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Enter a name for your binding, for example, CICSSOAPBinding. In the Port Type combo box arrow
pull-down, select the existing port type created earlier.
In the Protocol combo box arrow pull-down, select the SOAP protocol, and make sure that document
literal is checked as SOAP Binding Options:
x
specify Binding Details
Spedify the details of the binding that will be created

Name | CICSSOAPBinding

Port Type It1s:AcctDetaiIPortT~,'pe j
Protocol: -

SOAP Binding Options
% document literal
" rpc encoded

Einish I

Cancel

Figure 41, SOAP Binding Options in Generate Binding Wizard

Click Finish. The Binding is now linked with Port Type(s).

Your new Binding will appear in the Graph view:

Messages
Bl ] AcctDetailMessage

P AcctDetailRequest (xsdl:DFHCOMMAREA)
[P AcctDetailResponse (xsd?: DFHCOMMARER]

Port Types
B B AcctDetailPort Type

E & AcctDetailOperation |—)
—— [Ainput

<11 output

Bindings
B[] cicssoareinding
;Og soap:binding
B @, AcctDetailOperation
s0ap:operakion

B

soap:body
B 11 output
@ soap:body

Figure 42, Graph View Showing New Binding

You will need to set the soap:binding and soap:operation styles to document.
This is done using the soap:binding and soap:operation editor sections. Bring up the respective editor
sections by clicking on soap:binding and soap:operation under Bindings.

soap:binding soap:operation

Propert: | Walue Propert | Yalue

required required

ctvle soapdction http:/fexample. comClaimQueryOperation
transport: http:ffschemas. xmisoap.org/soap/http skyle document .

4

| [

4

Figure 43, Setting Binding and Operation Styles

The style entry is a pull-down combo box. Make sure that you select document as style for both
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soap:binding and soap:operation.

You’ll finish the binding by associating input soap:body with the AcctDetailRequest part and output
soap:body with the AcctDetailResponse part. You do that using the soap:body editor sections. Type
AcctDetailRequest and AcctDetailResponse into the “parts” property:

soap:body soap:body

Propett | Yalue - Propert I Walue -
encodingStvle encodingStyle

namespace namespace

parts AcctDetailRequest parts AcckDetailResponse

required | [required |
tvpe bype

use literal || |use likesral 4
| | _>|_I 1] | LI_I

Figure 44, Completing the Binding

Add the CICS SOAP Service. The service definition completes our task by associating an address or
endpoint to the binding.

Using the Services section you will create the service. Then right-click on the Services section heading.
Select Add child > service. The following dialog appears:
3 x|

‘ﬁ* New Service

K I Cancel |

Figure 45, Creating the Service

Type your service name in this dialog (for example, CICSSOAPService) and click OK.
CICSSOAPService service is created in the Services section:

Services

Figure 46, Services Section

Now create a port for your CICSSOAPService. In the Services section of the graph view, right mouse
click on CICSSOAPService then select Add Child->Port. In the ensuing dialog, type your port name in
the Name field (for example, CICSSOAPServicePort), select CICSSOAPBinding as Binding and SOAP
as protocol. In the SOAP Port details’ Location field, type the HTTP address of the CICS SOAP server
you wish to access with this Web Service, for example,
http://winmvsnO.cpit.hursley.ibm.com:8888/CICS/XMLS/DFHWSDSH/ACTDSOAP

(The URL is used to communicate with the back end server and server side program(s) and it represents
the CICS SOAP XMLE driver on the z/OS system.)

The filled Port dialog is shown in Fig. 47.
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x

Specify Port Details
Specify the details of the port that will be created

Name | CICSSOAPServicePort

Binding | tns:CICSS0APBinding =l

Protocal: [SOAP =l

SOAP Port Details

Location: I,-'"f\'inmvsntl.cpit.hursley.il:-m.cu:-m:8888,f'CICS,f.\{MLS,f'DFH'\-'-a'SDSH,f'ACI'DSOAP

Finish I Cancel

Figure 47, Creating a Port

Your WSDL file is complete. You can save the WSDL file and verify that it is correct by running the
WSDL verification. Select the WSDL verification tool icon on the tool bar:

B &l

Figure 48, Validate WSDL Document Icon

If the WSDL is correct, you will see the following message:
‘ﬁ’ ¥alidation Succeeded : il

@ The WSDL file is valid.

Figure 49, Validation Succeeded Dialog

The final WSDL file is shown here:

<?xml version="1.0" encoding="UTF-8"7?>
<wsdl:definitions name="AcctDetailWsdl"
targetNamespace="http://example.com"
xmlns:tns="http://example.com"
xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/"
xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/"
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsdl="http://www.DFHOACTDI.com/schemas/DFHOACTDIInterface"
xmlns:xsd2="http://www.DFHOACTDO.com/schemas/DFHOACTDOInterface">
<wsdl:types>
<xsd:schema xmlns:xsd="http://www.w3.0rg/2001/XMLSchema">
<xsd:import
namespace="http://www.DFHOACTDI.com/schemas/DFHOACTDIInterface"
schemalocation="DFHOACTDI.xsd"></xsd:import>
<xsd:import
namespace="http://www.DFHOACTDO.com/schemas/DFHOACTDOInterface"
schemaLocation="DFHOACTDO.xsd"></xsd:import>
</xsd:schema>
</wsdl:types>
<wsdl:message name="AcctDetailMessage">
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<wsdl:part name="AcctDetailRequest" element="xsdl:DFHCOMMAREA"></wsdl:part>
<wsdl:part name="AcctDetailResponse" element="xsd2:DFHCOMMAREA"></wsdl:part>
</wsdl:message>
<wsdl:portType name="AcctDetailPortType">
<wsdl:operation name="AcctDetailOperation">
<wsdl:input message="tns:AcctDetailMessage"
name="AcctDetailOperationInput"></wsdl:input>
<wsdl:output message="tns:AcctDetailMessage"
name="AcctDetailOperationOutput "></wsdl:output>
</wsdl:operation>
</wsdl:portType>
<wsdl:binding name="CICSSOAPBinding" type="tns:AcctDetailPortType">
<soap:binding style="document" transport="http://schemas.xmlsoap.org/soap/http" />
<wsdl:operation name="AcctDetailOperation">
<soap:operation soapAction="http://example.com/AcctDetailOperation”
style="document"/>
<wsdl:input name="AcctDetailOperationInput">
<soap:body use="literal" parts="AcctDetailRequest"/>
</wsdl:input>
<wsdl:output name="AcctDetailOperationOutput ">
<soap:body use="literal" parts="AcctDetailResponse"/>
</wsdl:output>
</wsdl:operation>
</wsdl:binding>
<wsdl:service name="CICSSOAPService">
<wsdl:port name="CICSSOAPServicePort" binding="tns:CICSSOAPBinding">
<soap:address
location="http://winmvsnO.cpit.hursley.ibm.com:8888/CICS/XMLS/DFHWSDSH/ACTDSOAP" />
</wsdl:port>
</wsdl:service>
</wsdl:definitions>

5.3 Using the Batch Processor (XSEBATCH)

New in WSED Version 5.1.2 is the ability to create the complete set of converters, drivers, schemas, and
WSDL files using a command-line batch program. The use of this program, XSEBATCH, is described in
detail (complete with samples) in the on-line help for WSED 5.1.2. To invoke on-line help in WSED,
select Help->Help Contents in the workbench toolbar. When the help is displayed, navigate to the Batch
Process chapter of the Developing section:

Developer
WebSphere software Information ce
Search:|  |[EH  Seanhscope: Alltopics
Contents @43 Developing & Eé@ 1 &
@ product overview =l Batch Processor -

Scenarios
@ Tutorials and samples

The batch processor is a command-line interface for creating enterprise Wehb
Q Configuring

services descriptions (W3DL) and message convetters for C1ca® and Mg
Developing applications. ¥ou communicate generation options to the processor in options
8 copoL spplications files. This tool is useful if you need to create many services from a set of COBOL
L2 puit spplications — | source files.
[ pissembler applications
= g; EML intetfaces For COBOL applications
L Introduction to ML Ensblement for the Enterpi
18] Creating an KML interface with XML Enablarner

You have three files in which to provide the necessary options to the batch
Processor:

» Containeroml

LB 41 10 cOBOL mapping tools o PlatformProperties sl
15] IMapping XML to COBOL » Servicedpecification i
B Setting preferences For ¥ML Enablernent For the

The reason for specifiring most of the options in XML files is to allow automation

Bl Creating and populating options fles of the options generation by customization tools such as WEED cotrverter and o
Bl Starting the batch pracessor service generation wizards.
SR —
Bl GenerationSnec 1| Related tasks
. ol
(-] | = | Bl Creating and populating options files ~|

Figure 50, Batch processor on-line help
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If you intend to create web services from many business applications at once, the use of the batch
processor greatly simplifies generation of multiple sets of converters and the WSDL files.

5.4 Testing your Web Services-enabled business application

To test your Web Services enabled application you will use Web Services explorer. You can find the

complete set of documentation on using the Web Services Explorer in the on-line WebSphere Studio
Information Center.

Right-click on the WSDL file you created and select Web Services > Test with Web Services Explorer.
You will see the Web Services Explorer view:

‘ﬁ’ Resource - Web Browser - IBM WebSphere Studio Enterprise Developer

_ =3
File Edit Mavigate Search Project Run  Window Help
IS -BR & 8a-|2]lve-o-
== Mavigatar v x || | welcome | | DFHOACTD. wsdl b4
& - =
,E C» E | . wWebh Services Explarer & o B 1%
-l #ML Account Test
‘@] DFHOACTD.chl
@) DFHOACTD wsdl £5. Mavigator &5 4 Actions =]
] DFHOACTDD. chl 2, WEDL Main &7 wsDL Binding Details -
1®] DFHOACTDL.cbl

18) DFHOACTDLsad =@ fle:/C: fwsed 112515/ wsCICS
. =N :
‘@] DFHOACTDO. chl

Shiowr below are the details for this SOAP <binding= element.,
Click on an operation to fil inits parameters and invoke it or specify
additional endpoints.

~ DOperations

AcctDetailOperation | --

2= outline % | |
a0 outline is not awvailable, v Endpoints Add Remove

T -

[i] Status A

IWABD3S1I file:/C: fwsed1 12515 fwsCICSWhitePaper /XML Account T¢
4| | v| (4] | |
—

<}i¢¢ i

37| Tasks (0 items)
Tasks ]Console

4

w X

Figure 51, Web Services Explorer View
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Navigate to the AcctDetailOperation in the Web Services Explorer Navigator view:
~laix]

File Edi Navigste Search Projsct Rum Window Help

[5-Ras]0]%-

[ 9]l &=~

= welcome x|
’% wieh Services Explarer @ i}
25 Navigator © 7 Actions &
[ =5 Invoke LT T
i% WSDL Main nvoke a WSDL Operation 20UICE
=@ file:/C: fiwsed 112515 s CICSWh
Ehdl CICS50APSErvice Eriter the pararneters of this WSDL operation and click Go to involke.
=& (ICS504PEinding Endpaints
- e e ation|
[http://90.30. 133, 11:8081/CICS/XMLS/WSSOAPHT /ACTDSOAP 7|
v DFHCOMMARER
custno int
acctno int

balance decimal

Go | Reset |

[i] status A

IWABDZSLI fie: fC: fwsed 112515 wsCICSWhitePaper fXML Account Test/DFHOACTD wsdl v
[l | v L4l | L]

77 Tasks (0items) % 0
| Tasks | consale

Figure 52, Web Services Explorer Navigator View

Enter customer number (for example, 4) and zeros in other fields (you need to do that if you specified the
whole DFHCOMMAREA as the input parameter. Alternatively you could have unselected acctno and

balance from the inbound messages structure selection page when you generated converters:
_iaix]
File Edt Mavigate Search Project Run Window Help

Is-geeals-+wa-=-

I |[ ] Welcome x|
’% wyeh Services Explorer @ = )

5] Navigator & 7 Actions

!El WEDL Main =8 Invoke a WSDL Operation DOLITE —

@) fle:C: fwsad1 12515 wsCICSWhit

E.@acssoADsgm:e Enter the parameters of this WSDL operation and click Go to invoke.
=8, CI i Endpoints
&

[http://90.30.133.11:8081 /CICS/XMLS/WSSOAPHT /ACTDSOAR x|

 DEHCOMMARES

custng int
4
acctno int
]
balance decimal
0 |
Go I Reset‘ -
[i] Gtatus 4
IWWAB03S1I file:/C: fuwsed1 12515 wisCICSWhitePaper f¥ML Account Test/DFHOACTD. wadl
< | 3 K | 0|
—
‘57 Tasks (i1 itams) W 3w x

 Tasks | Console |

Figure 53, Entering the Customer Number

To test your web services, press the Go button in the invocation form.
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The operation gets executed, and the results of executlng your application as a Web Service are returned:

4k Resource - Web Browser - IBM WebSphere Studio Enterprlse Developer ol x|

File Edit Wavigate Search Project Run Window Help

=E 18] % IJeIJ*%w

[ jwelcome | o) DFHOACTD.wsd piel X I

,% Weh Services Explorer < o E B @ P
25! Mavigator &5 4 | | [# actions 2N

=@ INYOKE d WoUL Operauun ar =
2 WSDL Main
=@ file:/C: fwsed 112515 wsCICSWhitePap
EI.@,CICSSOADSEMEE Enter the parameters of this WSDL operation and click Go to invoke,

=} 0 CICSSOAPElndlng Endpoints
eration|

[http:£9.30.133. 11:808 1/CICS/XMLSWES0APHT JACTDSOAR | ‘

~ DFHCOMMARES

custno int

4

acctno int

o

balance decimal

o |

GD‘REet‘ hd

[i] status
~ DFHCOMMAREA

custno (nt): 4
acctno (int): 5

4 | » balance (dedrmal): 10.00

4 y| 9

| %7 Tasks (0 ttems) W R x |
| Tasks ICunsoIe |

Figure 54, Results of Executing the Application

5.5 SOAP Error reporting

XML Enablement Converters, generated with the “CICS SOAP” driver type selected, return a SOAP
Fault message to the service requester if an error is encountered during processing of a request. The
message will always cite the senders request as the source of the problem and provide detail on the actual
error that occurred.

<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/" >

<SOAP-ENV:Body>

<SOAP-ENV:Fault>

<SOAP-ENV:Code>

<SOAP-ENV:Value>SOAP-ENV:Sender</SOAP-ENV:Value>

</SOAP-ENV:Code>

<SOAP-ENV:Reason>

<|[CDATA[IGZ0282S XML to data structure conversion could not complete in program "ACTSOAPI"
because no element names in the XML document were recognized by the converter.]]>

</SOAP-ENV:Reason>

</SOAP-ENV:Fault>

</SOAP-ENV:Body>

</SOAP-ENV:Envelope>
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You can see the results of a SOAP fault in the Web Services Explorer by switching to the source view of
the Status window:

[i| Status 7

Source

There is nothing to be displayed in the form view, Please switch to the source view for the
SOAP request and response,

Figure 55, Results of a SOAP Fault

The fault message in the SOAP Response Envelope will look as follows:

‘ﬁ’ Resource - Web Browser - IBM WebSphere Studio Enterprise Developer = Iﬁ' ILI

File Edt Mavigate Search Project Run  Window Help

IB-BEa|lglm-|l7]lce-9-
E | Wielcome | ] DFHOACTD wsdl x ] ] diroout
,% weh Services Explarer @ o K
[i] status e
<?uml version="1.0" encoding="UTF-8" 7> Bl =

- <S0AP-EMNY:Envelope rmilns:SOAP-EMW="http: f fschemas.xmlsoap.org/soapfenvelope/"
wmins: q0="http: { fvoww.DFHOACTDI.com/schemas /DFHOACTDIInterface”
smilnsxsd="http: f fwsww.w3.0rg/ 2001/ XMLSchema" xmins:xsi="http: f fvrww.w3org /2001 XMLSchema-
instance’>

- <SOAP-ENV: Body =
- «glWrapper>
- <DFHCOMMAREA=
<Custno=d</oustno=
</DFHCOMMAREA
=fql:Wrappers=
<fS0AP-ENV:BOdy =
«fS08P-ENYV Envelope=

4|

~ SOAP Response Envelope:

- <50AP-ENV:Envelope xmins:SOAP-EMNV="http: f fschemas.xmlsoap.org/soapfenvelope/”
#mins:q0="http: f f wwWwW.DFHOACTDI.comfschemas /DFHOACTDIInterface”
wmilns xsi="http: f fveviw.w3.0rg /2001 /XMLSchema-instance”
smilns xsd="http: f fweww.w3.0rg/ 2001/ XMLSchema' >
- <S04P-ENV:Body>
- <SOAP-ENV:Faults
- <50AP-ENV:Code
=S0AP-ENY Value=SOAP-ENY:Sender<,/S0OAP-ENY:Walue=
< fSOAP-EMNY:Codes
- <30AP-ENV Reasonz
<I[CDATA[ IGZ0282% ML to data structure conversion could not complete in program "ACTSO0API™
because no element names in the XML document were recognized by the conwverter. ]]=
< fS0AP-EMNY:Reasonz
=/504P-EMNV: Fault>

A ACOAN BRI GO e A

| — |5

Kl

4]

Dore

Figure 56, SOAP Response Envelope
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6 Appendices

6.1 Appendix A. Pre-requisite software

The following software is required to develop and run sample applications described in this paper:

CICS Transaction Server for 0S/390 Version 2 Release 2 (program number 5697-E93) or later with
the SOAP for CICS feature (HCAV100) installed.”

IBM Database 2 Universal Database Server for 0S/390 (DB2) Version 6 Release 1 (program number
5675-DB2) or later

IBM Enterprise COBOL for z/OS and OS/390 Version 3 Release 1 (program number 5648-A25) or
later with PTF for APAR PQ80513 (Available April 2003)

IBM Language Environment® for OS/390 Version 2 Release 10 (program number 5647-A01) or later
with PTF for APAR PQ65085 (Available Sept. 2002)

IBM WebSphere Studio Enterprise Developer for Multiplatforms Version 5.1.2 (program number
5724-B67) or later

0S/390 R8/R9/R10 and z/OS V1R1 support for Unicode ™ is required for the XML converters
generated by WebSphere Studio Enterprise Developer, General Availability release’.

! Soap for CICS (Feature HCAV100) is available free of charge at: http://www.ibm.com/cics/soap

2 0S/390 R8/R9/R10 and z/OS VIR1 support for Unicode ™ can be obtained free of charge at
https://www6.software.ibm.com/dl/0s390/unicodespt-p . This support is integrated into z/OS Version 1 Release 2 and later.
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6.2 Appendix B. Modifying COBOL Generator preferences

You access COBOL generator default preferences by selecting
Window > Preferences from the Workbench menu bar. The following dialog will appear.

x

Workbench

- Build Order
[ Component Test [¥ Perform build sutomatically on resource modification
- Data [ save all modified resources aukomatically prior ko manual build
B Detiug W Link Mavigator selection to active editor
[+-EGL
[ Enterprise Services [ Refresh Workspace on startup
[#- External Tools

- Help Warkspace save inkerval (in minutes): I 5

- InstallfUpdate

- Inkernet

- 12EE Open mode
[#-Java % Double click.

- Logging ' Single click

[#- LPEX Editor

[#- Plug-In Development
[#- Profiling and Logging [T openwhen using atrowkeys

- Readme Example Moke: This preference may not take effect on all views
[#]- Scripks

- Server

- Spell Check,

[#]- Team

- \talidation

- 'WaS Debug
[#-\Web and %ML Files
- \Web Browser
H-Web services
H-Web Tools

H- WML

]-{XML Enablerent for the Enkerprise
H- 2/05 Build Options

- z#05 Distributed Build Servers

[#- 2/03 Solutions

- 2105 Staged Developrment
4 | | _’I Restore Qefaultsl Apply |

[" Select on hover

[ 0 B B e B

Import, .. | Export., .. | a4 I Zancel |

Figure 57, Workbench preferences dialog

Expand XML Enablement for the Enterprise, expand Generate XML Converter Wizard and then select
the COBOL Generator page.
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The following dialog will appear:
&b preferences =]

- Agent Controller ~| | cosoL Generator
[+ &nk

[+]- Basic JCh
- Build Order —Specify options for the “ML converter

- Component Tesk
-Data Program narme: | HCMY

- Debug Author name: I WSED
-EGL

-Help Inbound code page: |114D UsA, Canada, etc, Euro Counkry E:cj
- Install/Update
- Inkernet

- J2EE Outbound code page: |114D UsA, Canada, etc, Euro Counkry E)cj
H- Java

- Logging

- LPEX Editor

|- Plug-In Development

+-Profiling and Logaging [ Decimal point is cormma
H

H

[ I IO s A B |
(sl g g i g |

Host code page: |114E| 1154, Canada, etc, Euro Country Exﬂ

frul

—#&dvanced generation options

-RAD

- Server

- apel Check

- Symptam Database

- Team

- 1ML Visualization

- YWaisen Migration

- Walidation

- As Debug

- Web and ML Files

- Web Browser

-Web Services

- Web Tools

AML

- ¥ML Enablement For the En
E ngerate ML converks

----- i L Generator Y
7 Reskare Defaulks | Apply |

Import. .. | Export... | Ok I Cancel |

[ Generate minimum hierarchy in ML Schemas

o O IO e O B

[ Generate groups in XML Schemas

[ 0 IO I s A B |
L

-
LUl

Figure 58, COBOL Generator preferences

Note that the entries on this page are very similar to the Options page of the COBOL converter generator
wizard. In fact, this preferences page is where the defaults for the wizard come from. The only
difference is the “Advanced generation options” section in which

e  When “Decimal point is comma” is selected, the functions of the period and the comma are
exchanged in PICTURE character strings and in numeric literals in a COBOL program.

e  When "Generate minimum hierarchy in XML Schemas” is selected, the generated XML schemas
will not contain the hierarchical structure that would reflect the original COBOL data structure
nesting level unless it is required to disambiguate similarly named data items.

e When “Generate groups in XML Schemas” is specified, the generated XML Schemas may
contain group model elements and references that are optional in the Web Services
Interoperability Basic Profile 1.0 specification (see http://www.ws-i.org/Profiles/Basic/2003-
08/BasicProfile-1.0a.htm). If you want your schemas to comply with WS-1 BP 1.0 leave this
option un-selected.
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6.3 Appendix C. Modifying COBOL Importer preferences

You access COBOL importer default preferences by selecting
Window > Preferences from the Workbench menu bar. The following dialog will appear.

# Preferences

LR L i
Agent Controller
At
Basic JCA
Build Order
Component Test
+]- Data
#]- Debug
- Help
- Install /Update
- Intemet
-J2EE
-Java
- Logging
- LPEX Editor
- Plug-In Developmert
- Profiling and Logging & rar AVES
-RAD
- Server
- Spell Check
- Symptom Database
- Team
- UML Visualization
-Walidation
-WAS Debug
- Web and XML Files
Web Browser
Web Services
Web Tools

1 Bl Bl Y

= =t e s

o]
o]
o]
&
&

[+

XML Enablement for the Enter

Figure 59, Workbench preferences dialog
Expand Basic JCA, expand importers and then select the COBOL page.
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#]- Workbench
- Agerit Corttroller
£ Ant
-] Basic JCA
E- Imparters
S COECL
-- Teminal Services
- Buid Order [EEENonfxtended  [¥]
- Component Test
- Data
- Debug
- Help
- Ingtall/Update
- Intemet
- JZEE
-Java
- Logging
- LPEX Editor
- Plug-In Development
- Profiling and Logging
- RAD
- Server
- Spell Check
- Symptom Database
- Team
- UML Visualization
- Validation
-WAS Debug
- Web and XML Files
- Web Browser
- Web Services
- Web Tools

Figure 60, COBOL Importer preferences

This dialog allows you to change COBOL options that affect the way XML converters treat COBOL data
items. Normally you should only modify the “Specify the compile options” section of this dialog, as the
rest of the preferences do not apply to the XML converters.
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6.4 Appendix D. XML Converter Interface

Both the inbound and outbound XML converters are invoked via a call statement. Arguments to
the converters are a mixture of input and output parameters whose contents may be changed upon return
from invocation. The call signature of the converters is displayed below:

CALL ‘CONV’ USING
DATA-STRUCTURE (input)
XML-MESSAGE-LEN (input + output)
XML-MESSAGE-TEXT (input + output)
(FEEDBACK-CODE or OMITTED) (output)
RETURING
CONVERTER-RETURN-CODE (output)

The above COBOL code is an example of a call to a converter. Input and output properties for
each argument are displayed in parenthesized italics. Since the structure of each argument is unique, it
must not vary from the description here.

DATA-STRUCTURE is a piece of storage whose structure is identical to that of the data
structure that was nominated as the inbound data structure when the converter was generated. During an
inbound conversion, DATA-STRUCTURE will be populated with values from the input XML document
provided in the arguments XML-MESSAGE-LEN and XML-MESSAGE-TEXT. In the case of an
outbound conversion, DATA-STRUCTURE is used to populate an XML message, whose properties are
placed in the XML-MESSAGE-LEN and XML-MESSAGE-TEXT arguments.

FEEDBACK-CODE is a 12 byte Language Environment Condition Token that can be omitted by
using the “OMITTED” keyword on the call. Choosing to omit this argument will cause any error
encountered by the converter to be signaled as a severe condition containing information about the error.
On the other hand not omitting this argument will cause the converter to simply place a condition token
representing the error into FEEDBACK-CODE without signaling a condition. The structure of
FEEDBACK-CODE is displayed below.

1 FEEDBACK-CODE.
2 CONDITION-TOKEN-VALUE.
COPY CEEIGZCT.
3 CASE-1-CONDITION-ID.
4 SEVERITY PIC S9(4) BINARY.
4 MSG-NO PIC S9(4) BINARY.
3 CASE-2-CONDITION-ID
REDEFINES CASE-1-CONDITION-ID.
4 CLASS-CODE PIC S9(4) BINARY.
4 CAUSE-CODE PIC S9(4) BINARY.
3 CASE-SEV-CTL PIC X.
3 FACILITY-ID PIC XXX.
2 I-S-INFO PIC S9(9) BINARY.

More detailed information about the structure and use of this condition token can be found in the
Language Environment Programming Guide.

CONVERTER-RETURN-CODE is an output only argument, which will contain one of two classes of
return codes upon completion of the call. If the converter encounters an error within its own facilities,
that is, not an error from the XML PARSE statement, then the Language Environment message 1D
associated with the error will be placed in the argument. The second class of return codes is the codes
returned from the XML PARSE statement. These will occur in the case where something was
syntactically incorrect in the input XML document. Note that this second class of errors only occurs
during an inbound conversion.
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6.5 Appendix E. Business applications program source
6.5.1 DFHOACTD

R Rk kI b b b b b I E b I b I I I I I I I I I I I I I I I I S I I I I I I I I I I I I I I I I I I I I I I I i 00600000

* * 01300000
* MODULE NAME = DFHOACTD * 02000000
* * 02700000
* DESCRIPTIVE NAME = $PRODUCT (Samples) EJB BankAccount Sample * 03400000
* * 04100000
*  $COPYRIGHT * 04800000
** * 05500000
* STATUS = $PLUO * 06200000
* * 06900000
* TRANSACTION NAME = None * 07600000
* * 08300000
* FUNCTION = * 09000000
*x This module accesses the DB2 BankAccount tables for * 09700000
xx the customer details. * 10400000
* % * 11100000
* * 11800000
* NOTES * 12500000
* LANGUAGE = COBOL 370 * 13200000
* * 13900000
e * 14600000
* 15300000
* ENTRY POINT = DFHOACTD * 16000000
K e e e e e e e * 16700000
* * 17400000
* CHANGE ACTIVITY * 18100000
*k * 18800000
* $MOD (DFHOACTD) , COMP (SAMPLES) , PROD ($PRODUCT) : * 19500000
* * 20200000
* PN= REASON REL YYMMDD HDXXIII : REMARKS * 20900000
* $PO= D03094 %PL 011016 HDFVGMB : Rework the EJB BankAccount * 21600000
Ak hkhhkhkhkkhkhhkhhkhkhkhkhhhhkhkhkhkhhkhhkhkhkkhkhhkhkhkhkhkkhkhkhkhhkhkhkhkhkhkhkhkhkhhkhkhkhhkhhrkhkhkhkhdkh*x 22300000
IDENTIFICATION DIVISION. 23000000
PROGRAM-ID. DFHOACTD. 23700000
ENVIRONMENT DIVISION. 24400000
DATA DIVISION. 25100000
WORKING-STORAGE SECTION. 25800000
26500000

EXEC SQL INCLUDE SQLCA END-EXEC. 27200000
27900000

01 TMP PIC X (40) VALUE SPACES. 28600000
01 SQL-MESSAGE VALUE SPACES. 29300000
05 MSG PIC X(10). 30000000

05 RC PIC X(10). 30700000

01 SQLERROR. 31400000
05 MSG2 PIC X(10) VALUE 'SQLERRM: ' 32100000

05 ERRM PIC X(5). 32800000

05 ERMC PIC X (70) VALUE SPACES. 33500000

01 SQLSTAT. 34200000
05 MSG3 PIC X (10) VALUE 'SQLSTATE: '. 34900000

05 SQLSTATT PIC X (5). 35600000

01 SQLERRORP. 36300000
05 MSG4 PIC X(10) VALUE 'SQLERRP: '. 37000000

05 SQLERP PIC X(8). 37700000
38400000

01 ABEND-MESSAGE. 39100000
05 MSG5 PIC X (12) VALUE 'ABEND CODE: '. 39800000

05 ABEND-CODE PIC X(4). 40500000
41200000

01 HV-DATA. 41900000
05 HV-CUSTNO PIC S9(9) COMP VALUE +0. 42600000

05 HV-ACCTNO PIC S9(9) COMP VALUE +0. 43300000

05 HV-BALANCE PIC S9(6)V9(2) COMP-3 VALUE +0. 44000000
44700000

LINKAGE SECTION. 45400000
01 DFHCOMMAREA. 46100000
05 CUSTNO PIC S99999. 46800000

05 ACCTNO PIC S99999. 47500000

05 BALANCE PIC S9999V99. 48200000
48900000
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PROCEDURE DIVISION.
START-PARA.

MOVE 999999999 TO ACCTNO

MOVE 'SQLCODE: ' TO MSG.
MOVE 'DFHOACTD PROGRAM STARTED. ' TO TMP.
EXEC CICS WRITEQ TD QUEUE ('CSMT')

FROM (TMP)

LENGTH (40)

END-EXEC.

MOVE CUSTNO TO HV-CUSTNO.
MOVE 'SEARCHING WITH CUST NO:' TO TMP.
EXEC CICS WRITEQ TD QUEUE ('CSMT')
FROM (TMP)
LENGTH (40)
END-EXEC.
EXEC CICS WRITEQ TD QUEUE ('CSMT')
FROM (CUSTNO)
LENGTH (5)
END-EXEC.
EXEC CICS HANDLE ABEND
LABEL (ABEND-PARA)
END-EXEC.

EXEC SQL SELECT ACCT NUMBER, BALANCE
INTO :HV-ACCTNO, :HV-BALANCE
FROM ACCOUNT
WHERE BALANCE IN
(SELECT MAX (BALANCE) FROM ACCOUNT
WHERE CUST ID = :HV-CUSTNO) END-EXEC.

MOVE SQLCODE TO RC.

EXEC CICS WRITEQ TD QUEUE ('CSMT')
FROM (SQL-MESSAGE)
LENGTH (20)
END-EXEC.

MOVE SQLERRML TO ERRM.

MOVE SQLERRMC TO ERMC.

EXEC CICS WRITEQ TD QUEUE ('CSMT') FROM (SQLERROR)
LENGTH (85) END-EXEC.

MOVE SQLERRP TO SQLERP.

EXEC CICS WRITEQ TD QUEUE ('CSMT') FROM (SQLERRORP)
LENGTH (18) END-EXEC.

MOVE SQLSTATE TO SQLSTATT.

EXEC CICS WRITEQ TD QUEUE ('CSMT') FROM (SQLSTAT)
LENGTH (15) END-EXEC.

IF SQLCODE EQUAL ZERO
MOVE HV-ACCTNO TO ACCTNO
MOVE HV-BALANCE TO BALANCE
END-IF.
GO TO RETURN-PARA.
ABEND-PARA.
EXEC CICS HANDLE ABEND
CANCEL
END-EXEC.
EXEC CICS ASSIGN
ABCODE (ABEND-CODE)
END-EXEC.
EXEC CICS WRITEQ TD QUEUE ('CSMT') FROM (ABEND-MESSAGE)
LENGTH (16) END-EXEC.
RETURN-PARA.
MOVE 'DFHOACTD PROGRAM STOPPED.' TO TMP.
EXEC CICS WRITEQ TD QUEUE ('CSMT')
FROM (TMP)
LENGTH (40)
END-EXEC.

EXEC CICS RETURN
END-EXEC.

49600000
50300000
51000000
51700000
52400000
53100000
53800000
54500000
55200000
55900000
56600000
57300000
58000000
58700000
59400000
60100000
60800000
61500000
62200000
62900000
63600000
64300000
65000000
65700000
66400000
67100000
67800000
68500000
69200000
69900000
70600000
71300000
72000000
72700000
73400000
74100000
74800000
75500000
76200000
76900000
77600000
78300000
79000000
79700000
80400000
81100000
81800000
82500000
83200000
83900000
84600000
85300000
86000000
86700000
87400000
88100000
88800000
89500000
90200000
90900000
91600000
92300000
93000000
93700000
94400000
95100000
95800000
96500000
97200000
97900000
98600000
99300000
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6.5.2 DFHOCSTD

R R R

*

F

*

*
*
*
*
*
*
*
*
*
*
*
*
*
* %
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*

kkhkkhkkhkkhkkhkkhkkhkkhkkhkkhkkhkkhkhkhkhkhkhkhkkhkhkhkhkhkhkkhkhkhkkhkkhkhkkhkkhkkhkkhkkhkkhkkhkkhkkkhkkkhkkhkkkkkkkkkkkkkkkkkk*x*%x

MODULE NAME = DFHOCSTD
DESCRI PTI VE NAMVE
. YCOPYRI GHT
STATUS = %°LUO
TRANSACTI ON NAMVE

UNCTI ON =
Thi s nodul e
the account

NCTES
LANGUAGE = COBCOL 370

CHANGE ACTI VI TY :
$MOD( DFHOCSTD) , COVP( SAMPLES) , PROD( %PRODUCT) :

PN= REASON REL
$PO= D03094 %L

= 9%PRODUCT (Sanpl es) EJB BankAccount Sanple

= None

accesses the DB2 BankAccount tables for
details.

YYMVDD HDXXI | | : REMARKS
011016 HDFVGWB : Rework the EJB BankAccount

*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*
*

| DENTI FI CATI ON DI VI SI ON
PROGRAM | D. DFHOCSTD.
ENVI RONVENT DI VI SI ON.
DATA DI VI SI ON
WORKI NG- STORAGE SECTI ON

01
01

01

01

01

01

01

L
01

EXEC SQL | NCLUDE SQLCA END- EXEC.

™P Pl C X(40) VALUE SPACES.
SQL- MESSAGE VALUE SPACES.
05 MG PI C X(10).

05 RC PI C X(10).

SQLERRCR.

05 MB& Pl C X(10) VALUE ' SQLERRM
05 ERRM PI C X(5).

05 ERMC PI C X(70) VALUE SPACES.
SQLSTAT.

05 MSG3 Pl C X(10) VALUE ' SQLSTATE:
05 SQLSTATT  PIC X(5).

SQLERRORP.

05 NMSG4 Pl C X(10) VALUE ' SQLERRP:
05 SQLERP PI C X(8).

ABEND- MESSAGE.

05 MSGh Pl C X(12) VALUE ' ABEND CODE:
05 ABEND- CODE PI C X(4) VALUE SPACES.
HV- DATA.

05 HV- CUSTNO PI C S9(9) COVP.

05 HV-FIRSTNAVE Pl C X(15).

05 HV- LASTNANE PI C X(25).

05 HV- ADDRESS PI C X(20) .

05 HV-C TY PI C X(20) .

05 HV- STATE PI C X(10).

05 HV- COUNTRY PI C X(15).

NKAGE SECTI ON,

DFHCOVMVAREA,

05 CUSTNO Pl C S99999.

05 LASTNAME PIC A(25).

05 FIRSTNAME PIC A(15).

05 ADDRESSL PIC X(20).

05 CTY PI C A(20) .

05 STATE PI C A(10).

05 COUNTRY  PIC X(15).

PROCEDURE DI VI SI ON
START- PARA

00600000
01200000
01800000
02400000
03000000
03600000
04200000
04800000
05400000
06000000
06600000
07200000
07800000
08400000
09000000
09600000
10200000
10800000
11400000
12000000
12600000
13200000
13800000
14400000
15000000
15600000
16200000
16800000
17400000
18000000
18600000
19200000
19800000
20400000
21000000
21600000
22200000
22800000
23400000
24000000
24600000
25200000
25800000
26400000
27000000
27600000
28200000
28800000
29400000
30000000
30600000
31200000
31800000
32400000
33000000
33600000
34200000
34800000
35400000
36000000
36600000
37200000
37800000
38400000
39000000
39600000
40200000
40800000
41400000
42000000
42600000
43200000
43800000
44400000
45000000
45600000
46200000
46800000
47400000
48000000
48600000
49200000
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I NI TI ALl ZE HV- DATA.
I NI TI ALI ZE SQLCA.

MOVE ' SQLCCDE: ' TO MSG
MOVE ' DFHOCSTD PROGRAM STARTED.' TO TMP.
EXEC C CS WRI TEQ TD QUEUE(' CSMI" )

FROM TMP)

LENGTH( 40)

END- EXEC.

MOVE CUSTNO TO HV- CUSTNO
MOVE ' SEARCHI NG W TH CUST #:' TO TMP

EXEC C CS WRI TEQ TD QUEUE(' CSMI" )
FROM TVP)
LENGTH( 40)
END- EXEC.

EXEC G CS WRI TEQ TD QUEUE(' CSMI" )
FROM CUSTNO)
LENGTH( 5)
END- EXEC.

EXEC CI CS HANDLE ABEND
LABEL ( ABEND- PARA)
END- EXEC

EXEC SQL SELECT CUST_LN, CUST_FN, CUST_ADDR, CUST Ty,
CUST_ST, CUST_CTRY INTO HV-LASTNANE . HV- FI RSTNAME,
: HV- ADDRESS, :HV-CITY, :HV- STATE, - HV- COUNTRY
FROM CUSTOVER WHERE CUST_ID = : HV- CUSTNO
END- EXEC

MOVE SQLCODE TO RC.
EXEC CI'CS WRI TEQ TD QUEUE(' CSMT" )
FROM SQL- MESSAGE)
LENGTH( 20)
END- EXEC.

MOVE SQLERRML TO ERRM
MOVE SQLERRMC TO ERMC.
EXEC CI'CS WRI TEQ TD QUEUE(' CSMI' ) FROM SQLERROR) LENGTH( 85)
END- EXEC.
MOVE SQLERRP TO SQLERP.
EXEC CI'CS WRI TEQ TD QUEUE(' CSMI' ) FROM SQLERRORP) LENGTH(18)
END- EXEC.
MOVE SQLSTATE TO SQLSTATT.
EXEC CI'CS WRI TEQ TD QUEUE(' CSMI' ) FROM SQLSTAT) LENGTH( 15)
END- EXEC.
IF SQ_CODE EQUAL ZERO
E HV- FI RSTNAME TO FI RSTNAME
ND\/E HV- LASTNAME TO LASTNANE
MOVE HV- ADDRESS TO ADDRESS1
MOVE HV-CI TY TO CI TY
MOVE HV- STATE TO STATE
MOVE HV- COUNTRY TO COUNTRY

MOVE ' DB2 ERROR - SEE CICS LOG TO LASTNAME
MOVE SQL- MESSAGE TO ADDRESS1
END- | F.
GO TO RETURN- PARA.
ABEND- PARA.
EXEC Cl CS HANDLE ABEND
CANCEL
END- EXEC.
EXEC CI CS ASSI GN
/ABCODE( ABEND- CCDE)
END- EXEC.
EXEC CI CS WRI TEQ TD QUEUE (' CSMI' ) FROM ( ABEND- MESSAGE)
LENGTH( 16) END- EXEC.
MOVE ' CI CS TRANSACTI ON ABENDED ' TO LASTNAME.
MOVE ABEND- MESSAGE TO ADDRESSL.
RETURN- PARA.
MOVE ' DFHOCSTD PROGRAM STOPPED.' TO TMP.
EXEC C CS WRI TEQ TD QUEUE(' CSMI" )
FROM TVP)
LENGTH( 40)
END- EXEC.

EXEC CI CS RETURN
END- EXEC.

49800000
50400000
51000000
51600000
52200000
52800000
53400000
54000000
54600000
55200000
55800000
56400000
57000000
57600000
58200000
58800000
59400000
60000000
60600000
61200000
61800000
62400000
63000000
63600000
64200000
64800000
65400000
66000000
66600000
67200000
67800000
68400000
69000000
69600000
70200000
70800000
71400000
72000000
72600000
73200000
73800000
74400000
75000000
75600000
76200000
76800000
77400000
78000000
78600000
79200000
79800000
80400000
81000000
81600000
82200000
82800000
83400000
84000000
84600000
85300000
86000000
86700000
87400000
88100000
88800000
89500000
90200000
90900000
91600000
92300000
93000000
93700000
94400000
95100000
95800000
96500000
97200000
97900000
98600000
99300000
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7

Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available
in your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation

Licensing

2-31 Roppongi 3-chome, Minato-ku

Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:INTERNATIONAL BUSINESS MACHINES
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not
in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part
of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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IBM Corporation

P.O. Box 12195, Dept. TL3B/B503/B313
3039 Cornwallis Rd.

Research Triangle Park, NC 27709-2195
US.A.

Such information may be available, subject to appropriate terms and conditions, including in some
cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement
or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated
through extrapolation. Actual results may vary. Users of this document should verify the applicable data
for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrates
programming techniques on various operating platforms. You may copy, modify, and distribute these
sample programs in any form without payment to IBM, for the purposes of developing, using,
marketing or distributing application programs conforming to the application programming interface for
the operating platform for which the sample programs are written. These examples have not been
thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs. You may copy, modify, and distribute these sample
programs in any form without payment to IBM for the purposes of developing, using, marketing, or
distributing application programs conforming to IBM's application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

(C) (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs.
(C) Copyright IBM Corp. _enter the year or years_. All rights reserved.

7.1 Programming interface information
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Programming interface information is intended to help you create application software using this
program.

General-use programming interfaces allow you to write application software that obtain the services of
this program's tools.

However, this information may also contain diagnosis, modification, and tuning information. Diagnosis,
modification and tuning information is provided to help you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a programming interface
because it is subject to change.

7.2 Trademarks and service marks

The following terms are trademarks or registered trademarks of International Business Machines
Corporation in the United States, or other countries, or both:

e CICS®

DB2®

IBM®

0S/390®

WebSphere®

'JTava™ and all Java-based trademarks and logos are trademarks or registered trademarks of Sun

Microsystems, Inc. in the United States and other countries.

Other company, product, and service names, which may be denoted by a double asterisk(**), may be
trademarks or service marks of others.

(C) Copyright IBM Corporation 2000, 2004. All Rights Reserved.
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